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Preface

The Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology
Network (OTN) Web site (http://www.oracle.com/technology/documentation/index.html) contains
the latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals
from the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation
folder available on your network from which you can access the Oracle|Agile documentation (PDF)
files.

Note To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later.
This program can be downloaded from the Adobe Web site (http://www.adobe.com).

The Oracle Technology Network (OTN) Web site
(http://www.oracle.com/technology/documentation/index.html) can be accessed through Help >
Manuals in both the Agile Web Client and the Agile Java Client. If applicable, earlier versions of
Oracle|Agile PLM documentation can be found on the Agile Customer Support Web site
(http://www.agile.com/support).

If you need additional assistance or information, please contact support@agile.com or phone (408)
284-3900 for assistance.

Note Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please
have ready the full part number, which is located on the title page.

Readme

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle
Technology Network (OTN) Web site
(http://www.oracle.com/technology/documentation/index.html).

Agile Training Aids

Go to the Agile Training Web page (http://training.agile.com) for more information on Agile Training
offerings.
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Chapter 1
Introduction

This chapter includes the following:

= What iS AGIle PLIM DAtAMAM?.......c.ccccueiieiicieisseisise s et ess st ss s bbbt snsssessssssasanes 1
= Who should Use Agile PLM DEAMAM? .........ccceirerriirirnieeeisesisreessssssssssessssssssssssssssssssssssssssssssesssssssssssssesssnes 2
= Agile PLM Datamart ArCHIECIUTE ......cuvvvieeeiieieiricieis ettt 2
= Agile PLM Datamart Sample CONfIGUIALION .......cvu vt 3

What is Agile PLM Datamart?

The Agile PLM Datamart provides a platform and tools that let you conduct multidimensional
analysis on Agile PLM data across the enterprise. Agile provides separate licenses for the following
datamarts:

@ Product Portfolio Management (PPM) Datamart
o Product Collaboration (PC) Datamart

= Product Quality Management (PQM) Datamart. Each Agile PLM Datamart product has the
following components:

o Datamart — a multidimensional database with a set of common dimensions and a set of star
schemas, each supporting a specific area of analysis — specifically, Product Collaboration,
Product Portfolio Management, or Product Quality Management.

o Agile PLM Analytics Plugin — software for connecting to the Agile PLM server to retrieve
metadata.

@ ETL tasks — a collection of Extracting, Transforming, and Loading (ETL) tasks for DT/Studio;
these are used to extract, transform, and load data into the Agile PLM Datamart.

Agile PLM Datamart schemas facilitate querying and reporting, which is valuable for analyzing
performance trends and estimating future trends, and provides an intermediate store for historical
Agile PLM data. Querying, reporting, and analysis require storage space and processing resources,
and could have a significant impact on application performance if they ran against the transaction
database. For this reason, Agile PLM and Agile PLM Datamart schemas have separate users, even
though they can exist on the same database instance. The Agile PLM Datamart database schema
is optimized for custom reporting, ad hoc queries, and analysis.

The Agile PLM Datamart contains all relevant data available in the Agile PPM, PC, and PQM
solutions. The data model for the Agile PLM Datamart is different from the data model for the Agile
PLM solutions in that it is better suited for querying and analysis. The Agile PLM Datamart is based
on a modular decision-support architecture with a set of common dimensions. It comprises a set of
star schemas—de-normalized Facts and a set of supporting Dimensions—each providing the basis
for an area of functional analysis such as Financial Analysis, Time-to-Market Analysis, and so on.

Agile PLM Analytics is an open platform for analysis, based on industry-standard technologies. It
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gives you direct access to your data and lets you import data from other sources.

Who should Use Agile PLM Datamart?

The Agile PLM Datamart is useful to the following kinds of users:

o Users with operational business process responsibility, such as executives and project
managers. These users can use the datamart for running standard reports and queries.

= Analysts or commodity managers who perform ad hoc queries and analyses in decision-making
situations, such as time-to-market analysis, cost management, issues resolution, or portfolio
score or trend analysis.

@ Managers who can use the datamart to gather information about key performance indicators
and historical trends.

o Information technology specialists who can integrate Agile PLM Datamart data with other
datamarts or the company’s data warehouse.

Agile PLM Datamart Architecture

Agile Analytics includes several components, as represented by the following diagram.

Star Schemas

Staging & /1—|

Agile PLM Dimensional

Database Schemas ‘
L U

Data Source Agile PLM Datamart

At the left of the diagram is the Agile PLM database, the transaction database that contains all Agile
PLM data and is designed for executing business processes and user interface needs. External
data sources are also represented at the left of the diagram.

For example, with the help of Agile Solutions Delivery, you may implement an analytics solution that
combines data from the Agile PLM database, external data sources, and additional flat files.
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Using ETL tasks, the data is extracted from the data sources and loaded into relational schemas
that comprise the Agile PLM Datamart:

1. Staging schema — a schema that contains raw data, which can be used for staging purposes
before moving to other datamarts.

2. Dimensional schema — a star schema that enhances the performance of multidimensional
gueries. The dimensional schema summarizes transactions into multidimensional views for
analysis and reporting, unlike the Agile PLM transactional database. User queries on the Agile
PLM Datamart are extremely fast because the data consolidation has already been done.

3. Administration schema — an administration schema that assists in the extract, transform, and
load operations, but primarily serves as an administration database.

Agile PLM Datamart Sample Configuration

The following figure shows a sample configuration for the Agile PLM Datamart.

-
|
|
| | Server
| | A
| |
| |
|
| Agile PLM Agile PLM
| Datamart | Database
| |
Lo 1
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Chapter 2
Requirements and Sizing

This chapter includes the following:

B SOfWAIE REQUITEIMENTS ..vuvviviciceeiiieteic ettt sttt b ae bbbttt s bbb bbbt s bbb s et n b s 5
I T 1 (0 Tl o T U (=TT o1 TSP 5
= Agile PLM Datamart SEIVET SIZING ....ccevveeriieriereeieisieesissieesisesesssseseassssss s ssssssesssssssssssesesssssssssssessssssesessssesssnnss 6
= Disk Space and Tablespace CONfIQUIALIONS..........ceiriuriieeiririrreer et 8

Important An Oracle database administrator should install the Agile PLM Datamart.

Software Requirements

This table gives information about the operating systems and other software used in the Agile PLM
Datamart.

Components Operating System Other Software

PPM Datamart Windows 2003 Server Oracle 9i R2 Enterprise Edition (9.2.0.1)* Oracle 10g
PC Datamart R2 Enterprise Edition (10.2.0.1) * Agile PLM Analytics

requires Oracle10g. If you are installing both Agile
PQM Datamart PLM Datamart and Agile PLM Analytics, Oracle9i is
not supported.

ETL components Windows 2003 Server Embarcadero Technologies DT/Studio 2.3.1

Agile PLM Analytics Plugin Windows 2003 Server Oracle Application Server 10g (10.1.2.0.2) or BEA
WebLogic Server 8.1 SP5 Agile PLM 9.2.1

Hardware Requirements

Before you can install Agile PLM Datamart server components, you must have at least 1 GB of
available disk space available where the OS is installed, in addition to the minimum disk space
requirements specified in this guide.

Important Agile PLM Datamart computers and databases should be dedicated to Agile and should
not have other software installed, unless otherwise specified. Do not attempt to include
other database schemas or use the Agile host server as the primary domain controller
(PDC) or dynamic host configuration protocol (DHCP) server.

Disk compression must be disabled on Agile computers.

When choosing a hardware configuration, consider the number of total users, the number of
concurrent users, the size of your database, the number of ECOs processed per day, and overall
activity level. If you have questions about your system, Agile Technical Support or your Agile
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Solutions Consultant can give guidance on whether you have small, medium, or large system
requirements.

It is required that the computer on which you are installing Agile PLM Datamart components and the
Oracle database have at least two physical drives or two partitions. This allows you to place the
operating system on the C drive and use the D drive for Agile or Oracle components.

The following table provides a summary information of minimum hardware requirements based on
database size.

Note These specifications are with Windows Operating System

Small database system (100 MB to 1 GB)

CPU Dual, 1.8 GHz Intel Xeon
RAM (GB) 1

Number and size of disks (partitions) Four 18-GB

Medium database system (1 GB to 5 GB)

CPU Dual, 1.8 GHz Intel Xeon
RAM (GB) 2

Number and size of disks (partitions) Four 18-GB

Large database system (2 GB to 16 GB)

CPU Four, 1.8 GHz Intel Xeon
RAM (GB) 4

Number and size of disks (partitions) Nine 18-GB

Extra-large database system (5 GB to 38 GB)

CPU Eight, 1.8 GHz Intel Xeon
RAM (GB) 8

Number and size of disks (partitions) Twelve 18-GB

The Agile PLM Datamart database uses Oracle 9.2.0.1.0 or 10.2.0.1. Recommended database
hardware depends on your Agile PLM Datamart system configuration.

If you have only single processor computers and anticipate high network traffic, then the database
and Agile Application Server should be installed on two different computers to avoid competition for
resources on a single computer, which would outweigh any advantage gained from reduced
network traffic.

Agile PLM Datamart Server Sizing

This section discusses the Agile PLM Datamart database design and architecture and provides
sizing and capacity recommendations for practical deployment. The person who will installs and
configures the Agile PLM Datamart should be knowledgeable about Oracle database
administration.
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The Agile PLM Datamart database is a Decision Support database that supports efficient OLAP.
Consequently, its design and architecture is different from the Agile PLM database. OLAP is a
resource intensive operation and the architecture goal is to optimize queries. The Agile PLM
Datamart database has more memory sorting than the Agile PLM database and a larger temporary
tablespace to accommodate long-running queries. To reduce full table scans, the database also
has more indexes.

For production databases, Agile recommends that you follow Oracle’s Optimal Flexible Architecture
(OFA) guidelines. OFA is a popular specification for configuring high performance, low maintenance
Oracle database systems.

Agile PLM Database Size

The target Agile PLM Datamart database size is directly related to the size of the source Agile PLM
database. Therefore, it is strongly recommended that the Agile PLM Datamart database use the
same database size model as the Agile PLM database. Typically the Agile PLM Datamart database
size will be larger than that of the corresponding OLTP database since historical data is preserved
in the datamart. The size of source data and the frequency of updates dictate how much space is
needed over a given period of time.

Agile PLM Datamart Database Growth Pattern

For future growth plans, you should understand your database growth pattern and leave room for
future growth. If the database data grows fast, then select a larger database size model or configure
the database with more hardware resources, especially disk space.

Frequency of Running ETL

Depending on the frequency with which you extract data from the Agile PLM database and how
long you intend to store the data on the Agile PLM Datamart database, you may need to plan for
more disk space for the extracted data.

Reporting Usage

Reporting is a resource intensive operation. For heavy reporting usage of a separate OLAP tool
(such as Agile Analytics) against the datamart, you should plan more hardware resource (additional
CPUs and memory) to achieve best performance and concurrency.

Hardware Resource Plan for Database Models

The following table lists recommended hardware resources for different database size models.

Database Size CPU RAM Disks (18 GB each)
Demo 1 512 MB 1
Small 2 1GB 4
Medium 2 2GB 4
Large 4 4GB 8
Extra-Large 12 8 GB 12
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Disk Space and Tablespace Configurations

While the proper sizing of extents minimizes dynamic extensions in the same segments, disk 1/0O
contention within the same logical tablespace or physical data file can also be harmful.

You can improve disk 1/0 performance for multiple disk configurations by spreading the 1/O burden
across multiple disk devices. The following sections describe the use of multiple disks for the Oracle
database server. It is always advisable to use more disks.

One-Disk Configuration

A one-disk configuration is best for a demonstration, pre-production, and testing environment. This
configuration results in disk I/O contention. In addition, as both usage and database size increase,
performance significantly declines. The one-disk configuration is intended for demo database
applications only, and the configuration can be implemented as shown in the following table

Disk Oracle Home Tablespaces Redo Logfiles
Disk 1 ORACLE_HOME SYSTEM TOOL LOG1 LOG2
UNDO LOG3
TEMP LOG4
USERS
INDX

AGILE_DATAL AGILE_DATA2
AGILE_DATA3 AGILE_INDX1
AGILE_ADW_DATAL
AGILE_ADW_DATA2
AGILE_ADW_DATA3
AGILE_ADW_DATA4
AGILE_ADW_DATA5
AGILE_ADW_DATA6
AGILE_ADW_INDX1 AGILE_ADW._INDX2
AGILE_ADW_INDX3 AGILE_STG_DATAL
AGILE_STG_DATA2 AGILE_STG_DATA3
AGILE_AAD_DATAL

There is no beneficial gain from OFA for the one-disk configuration from the perspective of disk 1/O
contention. There should be no significant impact on a current production database if you
implement the default Oracle settings with a one-disk configuration.

Two-Disk Configuration

A two-disk configuration is best for a small database. To eliminate potential I/O contention,
AGILE_DATA and AGILE_INDX data files are on separate disks. As usage and database size
increases, performance declines.
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Disk
Disk 1

Oracle Home
ORACLE_HOME

‘ Tablespaces
SYSTEM
TOOL

UNDO
AGILE_DATA1
AGILE_DATA2
AGILE_DATA3

AGILE_ADW_DATAL
AGILE_ADW_DATA2

AGILE_ADW_DATA3

AGILE_ADW_DATA4
AGILE_ADW_DATAS

AGILE_ADW_DATAG
AGILE_STG_DATAL AGILE_STG_DATA2

AGILE_STG_DATA3
AGILE_AAD_DATA1L

Redo Logfiles
LOG1
LOG2

Disk 2

TEMP
USERS
INDX

AGILE_INDX1 AGILE_ADW_INDX1
AGILE_ADW_INDX2 AGILE_ADW_INDX3

LOG3
LOG4

Four-Disk Configuration

A four-disk configuration is best for an enterprise-level implementation of Agile. A four-disk
configuration spreads the various data files, control files, and redo log files across multiple disk

devices.

= The three control files can be mirrored onto three different disks for best recovery protection.

@ All potential I/O demand-intensive data files can be distributed onto their own separate disk.
Redo log files are completely isolated from the rest of the data files, as the log files can cause
significant I/O contention during transactions if they are sharing disks with other data files. The
UNDO data file is separated from the schema data files and log files as well, so I/O contention
can be minimized.

= The Agile schema tablespaces can be isolated from the rest of the SYSTEM, TEMP, TOOL,
and UNDO data files.

The four-disk configuration shown in the following table is recommended. For production database
sites, the four-disk configuration represents the minimum requirements for an OFA implementation
and provides the minimum hardware configuration for performance tuning.
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Disks Oracle_Home Tablespaces Redo Logfiles Control files
Disk 1 ORACLE_HOME SYSTEM TOOL UNDO LOG1/2/3/4 Controlfile01
Disk 2 TEMP USERS INDX Archive log file Controlfile02
Disk 3 AGILE_DATAL AGILE_DATA2 Controlfile03

AGILE_DATA3

AGILE_ADW_DATA1L
AGILE_ADW_DATA2
AGILE_ADW_DATA3
AGILE_ADW_DATA4
AGILE_ADW _DATA5
AGILE_ADW _DATA6
AGILE_STG_DATAL
AGILE_STG_DATA2
AGILE_STG_DATA3
AGILE_AAD_DATAL

Disk 4 AGILE_INDX1

AGILE_ADW_INDX1
AGILE_ADW_INDX2
AGILE_ADW_INDX3

Eight-Disk Configuration

In addition to the advantages associated with a four-disk configuration, an eight-disk configuration
supports an enterprise-level implementation of Agile by further spreading various data files and
redo log files across multiple disk devices. Separating potentially large datafiles should help I/O
contention as physical disk I/O is inevitable, due to the share size of data, as shown in the following
table

Disks Oracle_Home Tablespaces Redo Logfiles Control files
Disk 1 ORACLE_HOME SYSTEM TOOL UNDO LOG1/2/3/4 Controlfile01
Disk 2 TEMP USERS INDX Archive log file Controlfile02
Disk 3 AGILE_DATAL AGILE_DATA2 Controlfile03

AGILE_DATA3
Disk 4 AGILE_ADW_DATA1

AGILE_ADW_DATA2
AGILE_ADW _DATA3

Disk 5 AGILE_ADW_DATA4
AGILE_ADW_DATAS
AGILE_ADW_DATAG

Disk 6 AGILE_STG_DATAL
AGILE_STG_DATA2
AGILE_STG_DATA3

Disk 7 AGILE_AAD_DATA1
AGILE_INDX1
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Disk 8 AGILE_ADW_INDX1
AGILE_ADW_INDX2
AGILE_ADW_INDX3

Twelve-Disk Configuration

Further separating the AGILE_DATA and AGILE_INDX tablespaces, twelve-disk configurations can
be implemented as shown in the following table.

Disks Oracle_Home Tablespaces Redo Logfiles Control files
Disk 1 ORACLE_HOME SYSTEM TOOL LOG1/2/3/4 Controlfile01
Disk 2 USERS INDX Archive log file Controlfile02
Disk 3 UNDO Controlfile03
Disk 4 TEMP
Disk 5 AGILE_DATAL AGILE_DATA2

AGILE_DATA3
Disk 6 AGILE_ADW_DATA1
AGILE_ADW_DATA2
Disk 7 AGILE_ADW_DATA3
AGILE_ADW_DATA4
Disk 8 AGILE_ADW_DATA5
AGILE_ADW_DATA6
Disk 9 AGILE_STG_DATAl
AGILE_STG_DATA2
Disk 10 AGILE_STG_DATA3
AGILE_AAD_DATAl
Disk 11 AGILE_INDX1
AGILE_ADW_INDX1
Disk 12 AGILE_ADW_INDX2
AGILE_ADW_INDX3
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Chapter 3
Agile PLM Datamart Installation

This chapter includes the following:

B INSEANALON PrOCESS. . ..ucvucereirereeserseiseiie et bbb 13
= Agile PLM Datamart INSTAIE ........c.cvvueeieeriirrcisiciesiets st sssss s s sesssessnnes 15
= Agile PLM Datamart Installation using Ant DB SCHPtS 0N SOIAIS .........cvurereeerieirinerrneeesieseseeseeseseseessssens 24
= Agile PLM Datamart Installation using Ant DB Scripts 0n WiNAOWS .........ceerirernirnnenneseneeseeseneeeseenens 28

Installation Process

Agile PLM Datamart is designed to run optimally on multiple computers. This guide is presented
with separate chapters for certain Agile PLM Datamart components. To set up an Agile PLM
Datamart system, you should install the components in the order shown in the following figure.
Agile PLM Datamart component installation order

Install DTiStudio (DT/Engine and DT Console ona

Embarcader DT:Studio separate Sener
Agile PLK Anahtics Install Agile PLM Analyiics Datamart on a separate
Datamart Database Databiase Server
Agile PLM Anahdtics Install Plug-in onthe PLM Application Serwver

Fluig-in
Agile PLM Anahtics Install PLMW Datarmart ETL components on the Server
Datamart ETL Cotponerts here DTAstI0 is instalec

Installing and Testing the Software

Install and test this release on a designated development server before installing it on your
production environment. Your development environment should mirror your production environment
as closely as possible to provide accurate testing results.

Important It is important to validate the installation of this release and confirm your integrations are
working correctly as part of your minimum due diligence. Any problems or questions noted
during your development system testing should be resolved before installing this release
on your production environment.
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Pre-Installation Requirements

Before installing the Agile PLM Datamart software, you need to log in to your computer with local
Administrator privileges and check the following:

@ Make sure you can ping all servers, including the database server, on which you plan to install
Agile PLM components. For example, try pinging the database server from the application
server.

= Verify the Domain Name System (DNS) hostname of each server on which you plan to install
Agile PLM Datamart components. In DNS, the fully qualified domain name consists of the
hostname, then a period, then the domain name.

Note When you are prompted by the Agile PLM Datamart installer to enter a
hostname, enter the fully qualified domain name of the server.

= Your Agile PLM application server must be installed and running on a separate computer.

= You must have local Administrator rights to the servers on which you plan to install Agile PLM
Datamart components.

Agile PLM Datamart Requirements

Before you start the installation, your Agile PLM database server (Oracle database 10g or 9i R2)
must be installed and running on a separate computer.

Agile PLM — Analytics Plug-in Requirements

Before you start the installation:

= You must stop the Web proxy server used for Agile PLM.

@ For Oracle Application Server, make sure the Agile PLM Application Server is running.
o For Weblogic Application Server, stop the Agile PLM Application Server.

Note If you have an application server cluster, install the plug-in on the repository
host server only. During installation, the Agile application is repackaged and
redeployed to all servers in the cluster.

After the installation, restart the Agile PLM Application Server (if necessary) and the Web proxy
server used for Agile PLM.

Datamart ETL Task Requirements

Before you start the installation:

@ Make sure Agile PLM application server is installed and running and using the most current
license key. See Updating the Agile License Key 15.

@ Make sure the Agile PLM Datamart database is installed and running.

o Install Embarcadero DT/Studio 2.3.1 components. This includes DT/Engine and DT/Console.
See Installing Embarcadero DT/Studio "Embarcadero DT/Engine Installation" 77.

o Make sure you have configured DT/Engine to connect to a database repository. For example,
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you can create a separate database user for DT/Engine on the Agile PLM Datamart computer
or on another Oracle database.

Updating the Agile License Key

When you purchase the Agile PLM Datamart, you should receive a new license key from Agile
Software. Make sure you update the license key for your Agile PLM system. Your license key
controls which Agile PLM Datamart ETL tasks can be run against the server.

To update your Agile license key using Agile Java Client:

Copy your new Agile license key to the Clipboard.

Start the Agile Java Client, and log in as an administrator.

Click the Admin tab.

Under Server Settings, double-click the Licenses node. The Licenses window appears.
In the License Key field, paste your new Agile license key.

Click Save.

N g ks w D

Restart the Agile PLM application server.

Note If you update the Agile license key after installing Agile PLM Datamart ETL
tasks, you must also restart the DTEngineManagerService and the DT/Engine
on the ETL computer.

Agile PLM Datamart Installer

The Agile PLM Datamart installer is a Java program. The installation of all components follows the
same initial process up through the screen where you select the components to install.

Before running the installer, make sure
@ You have enough available disk space.
2 You have disabled virus protection.

If virus protection is enabled, components used in the installer can be falsely identified as being
infected and lockup the installation. You can turn the virus protection on after the installation is
complete.

Note For information about any screen during the installation, click Help.

To start the Agile PLM Datamart installer on Windows:
1. Log into the computer using a login with local Administrator permissions.

2. Inthe Disk1\Windows directory, <double-click> the setup.exe file.

Note It is recommended that you do not install the PLM Datamart on the same drive
with the operating system. You should install the PLM Datamart directly under
the root directory (for example D:\PLM_Datamart). There must be at least 1 GB
of available disk space for the PLM Datamart installation.

3. In a few moments, the Welcome screen appears. Click Next. The License Agreement screen
appears.
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4. Read the Agile PLM Datamart license agreement. If you want to continue the installation
choose | accept and click Next. The Customer Information screen appears.

5. Type your user name and company hame. Your user name must be at least five characters.
Click Next. The Choose Component(s) screen appears.

* Database Server creates an instance of the Agile PLM Datamart on your database server.

*  Agile PLM - Analytics Plug-in installs additional libraries for integration with the Agile PLM
server.

* Datamart ETL Tasks installs software for extracting, transforming, and loading Agile PLM data
into the datamart.

Note Generally, you should not install all components on the same computer. When
you select a component, a description of it appears in the Description area.

If you need to install the Agile PLM Analytics Plugin, see Installing the Agile Analytics Plugin.

If you need to install the Datamart ETL Tasks, see Installing the Datamart ETL Tasks.

Installing the Datamart Database Server

This process follows the Choose Component(s) screen.

To install the database server:

1. Select Database Server. Click Next.
The Destination Location screen appears.

2. Specify a temporary location for the database instance scripts. Click Next.
The Choose Database Version screen appears.

3. Choose Oracle 10g unless you are upgrading with an existing Oracle 9i database. Click Next.
The Oracle Database Base & Home Directories screen appears.

4. Specify the path for the Oracle base and home directories. Click Next.
The Instance screen appears.

5. Specify the instance name you are creating. The default instance name is AADM. Click Next.
The Database Size Estimate screen appears.

Each database size has minimum memory and hardware requirements. This choice should be
made after considering existing disk space and anticipated size of your Datamart data.

6. Choose the size you anticipate needing for the PLM Datamart database. Click Next.

The Database Security and Datamart User Information screen appears.

* Internal / Sys Password - The SYS user owns all base tables and the user-accessible view of
the data dictionary. The default SYS password is Oracle.

®  SYSTEM Password - The SYSTEM user is used to create tables and views for administrative
information and internal tables and views used by various Oracle tools. The default
SYSTEM password is manager.

*  Datamart Admin User Password - The default password is aad.
*  Datamart Staging Schema Password - The default password is ast.
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10.

11.

12.

13.

14.

®  Datamart Dimensional Schema Password - The default password is adw.
Accept the defaults if you do not know the information required for each field. Click Next.
The Tablespaces (Data Files) screen appears.

Select the location of Oracle tablespaces (data files). You should accept the default settings,
unless you have additional hard drives with sufficient space available that allow you to
distribute the files across multiple hard drives.

The defaults are typically within the oracle\oradata directory. Accept the defaults if you do not
know the path required for each field. Click Next.

A second Tablespaces (Data Files) screen appears.

Select the location of Oracle tablespaces used for dimensional and staging data. You should
accept the default settings. Click Next.

The Control Files screen appears.

The data files to assign in this panel are:
e Control File 1

® Control File 2

* Control File 3

Control files are used to track the location of database files on the system. A control file
contains the database name, the name of the database files, and the names of the redo log
files. The control file also stores archive history.

Select the location of Oracle control files. You should accept the default settings, unless you
have additional hard drives with sufficient space available that allow you to distribute the files
across multiple hard drives. Click Next.

The Oracle Log Files screen appears.

Redo log files record changes made in an Oracle database. These files should be stored
separately from the datafiles. If a database or hard disk fails, you can use the redo log files to
update the database data back to the instant the failure occurred.

As records changes, it cycles through the redo log files. If an Archive Log is enabled, Oracle
will archive a redo log before overwriting it. The archived redo logs plus the online redo logs
provide a complete history of changes made to the database.

Type a path to store redo log files. You should accept the default setting unless you have
additional hard drives with sufficient space available that allow you to distribute the files across
multiple hard drives. Click Next.

The Pre-Installation Summary screen appears.

Check the information listed. If everything appears correct, click Install. If you need to change
information, click Previous until you find the fields that need to be changed.

When the progress indicator stops, you will receive a screen indicating that the install is
complete. Click Done.

If you need to install the Analytics Plugin or the Datamart ETL Tasks, restart the Datamart installer as
specified in Starting the Agile PLM Datamart Installer on Windows.

Depending on the components you installed, you may need to restart your computer. To complete
the installation of the Agile PLM Datamart Database, you must:
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@ Check the installation log files to make sure the database was created successfully.

@ If this is the first time you have created a database on that computer, add and configure an
Oracle Listener. See Adding and Configuring the Database Listener ( 18).

Checking Installation Logs on the Database Server
After you install Agile PLM Datamart components on the database server, go to the
<AnalyticsTemp> location to check for installation log files. The following log files appear:

B Service.log — log showing whether the database instance and database password file were
created.

= check_connection.log — log showing whether the installer was able to establish a connection to
the newly created database instance.

o DBinstall.log — installation log for creation of common tables used by the Agile PLM Datamart.
= PPM.log — Product Portfolio Management Datamart installation log.

o PC.log — Product Collaboration Datamart installation log.

= PQM.log — Product Quality Management Datamart installation log.

= AdvancedPPM.log — PPM Analytics installation log.
Adding and Configuring the Database Listener

The Oracle Listener supports client connections to the database. If this is the first time Oracle has
been installed on the current computer, you need to add and configure a new Listener.

If an Oracle database instance was previously installed on the computer before you installed the
Agile PLM Datamart database, you can skip adding a new Listener. However, you still need to
configure the Listener address for the Agile PLM Datamart, as described below.

To add a new Listener address:

1. Ifthe Agile PLM Datamart is the first database instance created on this computer, the Net
Configuration Assistant Welcome screen appears.

If there is already a Listener, click Finish. Otherwise, continue.

Select Listener Configuration. Click Next.

Select Add to add a listener to the database. Click Next.

Accept the default listener name, LISTENER, in the Listener Name dialog box. Click Next.
Accept TCP as the Selected Protocol. Click Next.

Accept the standard port of 1521. Click Next.

Select No when asked to configure another listener. Click Next.

The Listener configuration is complete. Click Next.

© © N o 0 s~ 0N

Click Finish to close the Oracle Net Configuration Assistant window.

To configure a new Listener address for the Agile PLM Datamart:

1. Start the Oracle Net Manager by choosing Start > Programs > Oracle - OraHome92 > Configuration
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and Migration Tools > Net Manager.
In the Oracle Net Manager window, double-click the Local folder and select the Listeners folder.
Click the name of the newly created listener, LISTENER.

Select Database Services in the Listening Locations drop-down list.
a. Click Add Database.
b. Inthe dialog box that appears, make the following changes:
=  Global Database Name: aadm
= Oracle Home Directory: oracle_home
=  SID: aadm

Note If you used a different global database name during the database installation,
change the information as appropriate.

Choose File > Save Network Configuration to save your changes.

Stop and restart the Oracle Listener service.
a. Select Start > Settings > Control Panel > Administrative Tools > Services.
In the Services dialog box, locate and select the Oracle Listener.

c. Right-click and choose Stop.
d. After the service stops, right-click and select Start.
e. Afterit restarts, close all open dialog boxes and windows.

Deleting an Existing Agile PLM Datamart Database Instance

When you purchase the Agile PLM Datamart, you can obtain licenses for any combination of the
PPM Datamart, PC Datamart, and PQM Datamart. If you later obtain additional Agile datamart
licenses, you can choose whether to install over the existing database instance or to delete the
existing database instance and create a new instance.

If you install over an existing Agile PLM Datamart database instance, there will be several errors in
the installation logs that say that the database, tablespaces, and database users already exist. You
can ignore these errors.

If you've already installed the Agile PLM Datamart and have obtained additional datamart licenses
from Agile, you can delete the existing database instance manually by using one of the following
approaches. Afterward, you can then install a fresh database instance.

To delete a database instance using Oracle’s Database Configuration Assistant:

1. Choose Start > All Programs > oracle_home > Configuration and Migration Tools > Database Configuration
Assistant.

Click Next.
Choose Delete a Database. Click Next.
Enter Username and Password

Select the SID associated with the Agile PLM Datamart. The default SID is aadm. Enter a
database username and password (such as system/manager). Click Finish.

o ~ DN

The Summary dialog box appears.
6. Click OK to continue.
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8.

A confirmation dialog box appears.

Click Yes to continue.

After the database is deleted, you are prompted whether to perform another operation.
Click No to exit.

Starting the Database Manually

If you restart the database server and notice that the database is idle even though the Oracle
Service is running, you can start the database manually using the STARTUP command.

To start the database manually:

1.
2.

Open a Command Prompt window.
Start SQL*Plus without connecting to the database:
<prompt> sqlplus /nolog
Connect to Oracle as SYSDBA:
SQL> CONNECT system/<SYSTEM_PASSWORD> as sysdba
Start the database:
SQL> STARTUP
Disconnect from Oracle:
SQL> DISCONNECT
Exit from SQL*Plus:
SQL> EXIT

Installing the Agile Analytics Plugin

This process follows the Choose Component(s) screen.

To install the Agile PLM Analytics Plugin:

1.
2.

Select Agile PLM Analytics Plugin. Click Next. The Application Server Type screen appears.
Choose either Oracle Application Server or Bea Weblogic Server.
* If you choose Oracle Application Server, the Oracle Application Server Home screen appears.

Specify the location of the Oracle Application Sever home (the default is c:\OraHome). Click
Next.

The Chose PLM Version screen appears.
Select one from the supported PLM versions and click Next.

* If you choose Bea Weblogic Server, the Weblogic Application Server Home screen appears.
Specify the location of the Weblogic Application Sever home. Click Next.

The Agile PLM Server Home Directory screen appears.

Type the directory where Agile PLM is installed. This directory is also referred to as the Agile
home. The default Agile home is root:\Agile\Agile21. Click Install.
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If you chose Oracle Application Server, you may receive messages about stopping Oracle and
redeploying Agile. Click Yes or OK to continue.

When the progress indicator stops, you will receive a screen indicating that the install is
complete. Click Done.

If you need to install the Datamart ETL Tasks, restart the Datamart installer as specified in Starting
the Agile PLM Datamart Installer on Windows. Depending on the components you installed, you
may need to restart your computer.

Installing the Datamart ETL Tasks

This process follows the Choose Component(s) screen on page 3-4.

To install the Datamart ETL tasks:

1.

Select Datamart ETL Tasks. Click Next.
The Installation Location screen appears.

Type the directory where you want to install Agile Analytics components. This directory is also
referred to as the Agile Home. Click Next.

The Agile PLM DT Engine Details screen appears.

The default administrator username is dtadmin and the default administrator password is
dtadmin123.

Type the administrator username and password for DT/Engine. Click Next.

The Agile PLM Database Details screen appears.

Note The database must be running and you must have a net service configured to
connect to it.

*  Agile Database Host Name is the fully qualified domain name of the computer where the Agile
PLM database server is installed.

* Agile Database Port is the database port. For Oracle. The default database port is 1521.

® Agile Database SID is the Oracle System Identifier that refers to the instance of the Oracle
database running on the server. The default SID is agile9.

®  Agile Database User is the database user. The default user is agile.

* Agile Database User Password is the password for the Agile PLM database user. The default
is tartan.

Note If your Agile PLM database is configured to use different values than the defaults
listed above, specify that information instead. If you do not know these values,
contact your Agile PLM database server administrator.

Type your source Agile PLM database information. Click Next.

The PLM Datamart Details screen appears.
Note The database must be running and you must have a net service configured to
connect to it.

®  PLM Datamart Database Host Name is the fully qualified domain name of the computer where
the Agile PLM Datamart database server is installed.

* PLM Datamart Database Port is the database port. For Oracle, the default database port is
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1521.

*  PLM Datamart Database SID is the Oracle System Identifier that refers to the instance of the
Oracle database running on the Agile PLM Datamart server. The default SID is aadm.

®  PLM Datamart Admin User Password is the Admin schema (AAD) database user password for
the Agile PLM Datamart. The default password is aad.

*  PLM Datamart Staging Schema Password is the Staging schema (AST) database user
password for the Agile PLM Datamart. The default password is ast.

*  PLM Datamart Dimensional Schema Password is the Dimensional schema (ADW)database user
password for the Agile PLM Datamart. The default password is adw.

Note If your Agile PLM Datamart database is configured to use different values than
the defaults listed, specify that information instead. If you do not know these
values, see the database administrator responsible for your Agile PLM Datamart
database server.

5. Type your destination Agile PLM Datamart database information. Click Next.
The Agile Analytics Login URL screen appeatrs.
This is the same URL that Agile SDK programs use to connect to the Agile PLM server.
Format: <protocol>://<fully_qualified_hostname>/<virtualPath>
Example: http://plm.agile.agilesoft.com/Agile
6. Specify the fully qualified URL to access the Agile PLM server. Click Next.
The Choose PLM Version screen appears.

Choose the Agile PLM version you currently have installed.

Note If you select Agile 9.2.1 PLM, click Next and continue to steps from 6a.
If you select either Agile 9.2.1.3 PLM or Agile 9.2.2 PLM or Agile 9.2.2.1 PLM, skip to step 7.

The Application Server Type screen appears.

a. Select the application server type on which PLM is running. Click Next.The Start of Fiscal
Year screen appears.

b. Specify the day and month that begins your company's fiscal year. Click Next. The Pre-
Installation Summary Window appears.

c. Review the information. Click Install. The Installation Complete screen appears.
d. You can chose to restart your computer now or later, but it must be restarted for the
changes to take affect. Click Done.
Continue to the section Checking the Installation Log on the ETL Server.
7. If you select either Agile 9.2.1.3 PLM or Agile 9.2.2 PLM or Agile 9.2.2.1 PLM, click Next.

The Get User Input screen appears.

a. Type the PLM user name and password, which was created in PLM for the ETL user. Click
Next.

The Application Server Type screen appears.
b. Select the application server type on which PLM is running. Click Next.

The Start of Fiscal Year screen appears.
c. Specify the day and month that begins your company's fiscal year. Click Next.
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The Pre-Installation Summary Window appears.
d. Review the information. Click Install.

The Installation Complete screen appears.

e. You can chose to restart your computer now or later, but it must be restarted for the
changes to take affect. Click Done.

Checking the Installation Log on the ETL Server

After you install Agile PLM Datamart ETL tasks on the ETL computer, check the following file for
any errors:

agile_homel\install\logs\Agile_PLM_Datamart_InstallLog.log

It lists all the ETL tasks that are installed. If you encountered any errors, you may need to re-install.
If you are unable to resolve a problem by r-einstalling, contact Agile Support.

Agile PLM Datamart ETL Folders

After Agile PLM Datamart ETL components are installed, the <AgileAnalyticsHome> folder has the
following subfolders:

Folder Contains

bin Extract, Transform, and Load (ETL) scripts used to extract and load Agile PLM data.
classes Java classes used to do the extraction and loading of data.

config Configuration files.

ETL Extraction, transformation, and load scripts.

lib Java libraries used by the ETL scripts.

logs Log files generated by the Agile PLM Datamart ETL scripts.

schema Contains the schema documentation for the Agile PLM Datamart.

Uninstalling Agile PLM Datamart ETL Tasks

If you want to undeploy Agile PLM Datamart ETL tasks from the DT/Engine repository, you can
uninstall them using Agile’s uninstall program. To remove DT/Studio components, use uninstall
programs provided with DT/Console and DT/Engine.

To remove Agile PLM Datamart ETL tasks:

1. Onthe ETL computer, make sure the DTEngineManagerService is started.

2. Choose Start > Programs > Agile > Agile PLM Datamart > Uninstall Agile PLM Datamart.
The uninstaller program starts.
Click Uninstall.

4. Click Done when finished.
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Agile PLM Datamart Installation using Ant DB Scripts on
Solaris

Before executing Agile Datamart Installer on Solaris, please ensure that the following are installed
= Apache-ANT

= JDK

o Qracle

Installing Apache-ANT

1. Download ant 1.7.0 zip from the location http://ant.apache.org/bindownload.cgi
(http://ant.apache.org/bindownload.cgi)

Unzip the files in a folder, say apache_ant

3. Download ant-contrib.jar from
http://svn.middleware.georgetown.edu/view/branches/Rel_1_3/lib/ant-
contrib.jar?view=log&root=java-idp&pathrev=2104
(http://svn.middleware.georgetown.edu/view/branches/rel_1_3/lib/ant-
contrib.jar?view=log&root=java-idp&pathrev=2104)

Alternately, you can download ant-contrib-1.0b2-bin.zip from
http://prdownloads.sourceforge.net/ant-contrib/ant-contrib-1.0b2-bin.zip?download
(http://prdownloads.sourceforge.net/ant-contrib/ant-contrib-1.0b2-bin.zip?download) and extract
ant-contrib.jar from it.

4. Move ant-contrib.jar to lib in apache_ant directory.

Set the ANT_HOME environment variable in .profile file (specify the path up to the parent folder of
bin)

ANT_HOME=/uO1/oracle/apache_ant/apache-ant-1.7.0; export ANT_HOME
6. Add an entry for ANT, in the PATH environment variable also, up to the bin folder.
For example: PATH=$PATH:$ANT_HOME/bin; export PATH

7. Re-login or execute ./profile to bring the changes to effect.

Installing JDK

1. Download the OS specific JDK version from http://java.sun.com/javase/downloads/index.jsp
(http://java.sun.com/javase/downloads/index.jsp)

Unzip the files to a folder, say j2sdk
3. Enable install permissions - chmod +x jdk-1_5 O<update>-solaris-sparcv9.sh

If you have downloaded j2sdk-1 4 2 12-solaris-sparcv9.sh then execute chmod +x jdk-1 4 2 12-
solaris-sparcv9.sh

4. Run the self-extracting binary by executing the command ./jjdk-1 5 O<update>-solaris-sparcv9.sh or
Jjdk-1_4 2 _12-solaris-sparcv9.sh, as applicable.
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5. Add an entry for jdk in the PATH environment variable
6. Point upto the parent directory structure where java.exe exists
PATH=$PATH:/u01/oracle/j2sdk1.4.2_12/bin/sparcv9;export PATH

Creating the Agile PLM Datamart Database on Solaris

To create the Agile Datamart database on Solaris:

1. Login as oracle user.

FTP AntDBScripts.zip to DBFILES_ORIG_LOCATION/AntDBScripts folder in Binary format.
Unzip AntDBScripts.zip.

Change mode of Solaris AntDBScripts folder: chmod -R 777 ./AntDBScripts

Set the environment variables, ORACLE_HOME, ORACLE_SID, PATH

export ORACLE_HOME =/u01/app/oracle/product/10.2.0/db_1
export ORACLE_SID=AADM
export PATH=$PATH:$ORACLE_HOME/bin

You can also modify the .profile file of oracle user
ORACLE_SID=AADM; export ORACLE_SID

6. Re-login or execute ./.profile to bring these changes into effect

ok e

Go to InstallerScripts folder under AntDBScripts and configure SolarisDBInstaller.properties -
/AntDBScripts/InstallerScripts/SolarisDBInstaller.properties according to the OPTION, viz., 1, 2, 3, 4
you select.

Options

Specify the option for the following
# 1. Creates new instance, new tablespaces
# 2. Use existing instance, creates new tablespaces
# 3. Use existing instance, existing tablespaces

# 4. Replaces tokens in all SQL files
OPTION =1

# Specify DB Type if you choose OPTION=1 and OPTION =2, Otherwise no need. Options are
Small, Medium, Large

DB TYPE = Large
# Specify Oracle version [10g/9i] if you choose OPTION=1 and OPTION=2 and OPTION=3,
Otherwise no need.

ORACLE_VERSION = 9i

# This is the folder where the source code is unzipped
DBFILES ORIG LOCATION = /u0l/oracle
# Specify Character Set if you choose OPTION=1.0Otherwise no need.
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CharecterSet = UTF8
# Database Instance Name if you choose OPTION=1.0Otherwise no need.
DB _SID = AADM

# Password for User AAD (Administration Schema) which gets created during installation. Specify
this for all options.

AAD PASSWORD = aad

# Password for User AST (Staging Schema) which gets created during installation. Specify this for
all options.

AST PASSWORD = ast

# Password for User ADW (Datamart Schema) which gets created during installation. Specify this
for all options.

ADW_PASSWORD = adw

# Specify ORACLE_HOME directory if you choose OPTION=1. Otherwise no need.
ORACLE_HOME = /u0l/app/oracle/product/10.2.0/Db 1

# sys user password if you choose OPTION=1. Otherwise no need.
ORACLE_INTERNAL USER PASSWORD = oracle

# system user password. Specify this for all options.
ORACLE SYSTEM USER PASSWORD = manager

# These are the file folder paths where respective table space data files have to be created

# Make sure that you create a folder with Database instance name (ex: AADM) in the respective
folders

# include forward slash "/" at the end of folder path

# This is for System Table space and SYSAUX Table space files if you choose OPTION=1.
Otherwise no need.

SYSTEM FILE LOCATION = /u0Ol/oracle/oradata/

# This is for Redo Log files if you choose OPTION=1.0therwise no need.
LOGFILE LOCATION = /u0l/oracle/oradata/

# This is for Temporary Table space files if you choose OPTION=1. Otherwise no need.
TEMPFILE LOCATION = /u0l/oracle/oradata/

# This is for Control files if you choose OPTION=1. Otherwise no need.
CONTROLFILE LOCATION = /uOl/oracle/oradata/

# This is for Undo Table space files if you choose OPTION=1. Otherwise no need.
UNDOFILELOCATION = /u0l/oracle/oradata/

# This is for Datamart Table space files if you choose OPTION=1 or OPTION=2. Otherwise no
need.
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DATAFILE LOCATION = /u0l/oracle/oradata/

# Specify no. of tablespaces (Both data and index) if you choose OPTION=1 and OPTION=2,
Otherwise no need.

NO_OF TABLESPACES = 15

# specify the new TS names to be created if you choose OPTION=1 and OPTION=2. Otherwise no

need.
TS1
TS2
TS3
TS4
TS5
TS6
TS7
TS8
TS9O
TS10
TS11
TS12
TS13
TS14
TS15

AGILE DATA1
AGILE_DATA2
AGILE_DATA3
AGILE_ INDX1
AGILE_AAD DATA1
AGILE_ADW DATA1
AGILE_ADW_DATA2
AGILE_ADW_DATA3
AGILE_ADW DATA4
AGILE_ADW_DATAS
AGILE_ADW DATA6
AGILE_ADW_INDX1
AGILE STG DATAl
AGILE_STG DATA2
AGILE_STG DATA3

# Update table space size in Small/Medium/Large.properties file for corresponding DB_TYPE if you

choose OPTION=1 and OPTION=2. Otherwise no need.

# Specify the Datafile name for new TableSpace if you choose OPTION=1 and OPTION=2.

Otherwise no need.

TS1 DATAFILENAME
TS2 DATAFILENAME = AGILE_DATA2

TS3 DATAFILENAME = AGILE DATA3

TS4 DATAFILENAME = AGILE INDX1

TS5 DATAFILENAME = AGILE AAD DATAL

TS6_ DATAFILENAME = AGILE ADW DATAL

TS7 DATAFILENAME = AGILE ADW_ DATA2

TS8 DATAFILENAME = AGILE ADW_DATA3

TS9 DATAFILENAME = AGILE ADW DATA4

TS10 DATAFILENAME = AGILE ADW_DATAS
TS11 DATAFILENAME = AGILE ADW_DATA6
TS12 DATAFILENAME = AGILE ADW_ INDX1
TS13 DATAFILENAME = AGILE STG DATAl
TS14 DATAFILENAME = AGILE_ STG_DATA2

AGILE DATAl
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TS15 DATAFILENAME = AGILE STG_ DATA3

# Mapping of Table spaces to DM Tablespaces Specify this for all options.

AGILE DATA1
AGILE DATA2
AGILE_DATA3

AGILE DATA1
AGILE_ DATA2
AGILE_DATA3

AGILE INDX1 = AGILE INDX1

AGILE AAD DATA1
AGILE_ADW DATA1
AGILE_ADW_DATA2
AGILE_ADW_DATA3
AGILE_ADW DATA4
AGILE_ADW DATAS
AGILE_ADW DATA6
AGILE_ADW INDX1
AGILE_STG DATA1
AGILE_STG DATA2
AGILE_STG DATA3

AGILE AAD DATAl
AGILE_ADW DATA1
AGILE_ADW_DATA2
AGILE_ADW_DATA3
AGILE_ADW DATA4
AGILE_ADW DATAS
AGILE_ADW DATA6
AGILE_ADW INDX1
AGILE_STG DATAl
AGILE_STG DATA2
AGILE_STG DATA3

Steps to run Database creation file

1. Go to <DBFILES_COPY_LOCATION>/AntDBScripts/InstallerScripts directory.

2. Enter the command ./SolarisAnt_Installer.sh

3. Log files are created in the following location
<DBFILES_COPY_LOCATION>/Solaris/Logs

Agile PLM Datamart Installation using Ant DB Scripts on
Windows

Before executing Agile Datamart Installer in Windows, please ensure that the following are installed
o Apache-ANT

= JDK

B QOracle

Installing Apache-ANT

1. Download ant 1.7.0 zip from the location http://ant.apache.org/bindownload.cgi
(http://ant.apache.org/bindownload.cgi)

2. Unzip the files in a folder, say apache_ant
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3. Setthe ANT_HOME as Windows environment variable.
For example: ANT_HOME=D:\apache_ant\apache-ant-1.7.0

4. Download ant-contrib.jar from
http://svn.middleware.georgetown.edu/view/branches/Rel_1_3/lib/ant-
contrib.jar?view=log&root=java-idp&pathrev=2104
(http://svn.middleware.georgetown.edu/view/branches/rel_1_3/lib/ant-
contrib.jar?view=log&root=java-idp&pathrev=2104)

Alternately, you can download ant-contrib-1.0b2-bin.zip from
http://prdownloads.sourceforge.net/ant-contrib/ant-contrib-1.0b2-bin.zip?download
(http://prdownloads.sourceforge.net/ant-contrib/ant-contrib-1.0b2-bin.zip?download) and extract
ant-contrib.jar from it.

5. Move ant-contrib.jar to ANT_HOME\lib directory.

Add an entry for ANT, in the PATH environment variable also.
For example: PATH=%PATH%;D:\apache_ant\apache-ant-1.7.0\bin

Installing JDK

1. Download Widows JDK version from http://java.sun.com/j2se/1.4.2/download.html
(http://java.sun.com/javase/downloads/index.jsp)

Run the downloaded executable file j2sdk-1.4.2_14.windows-i586-p.exe, say j2sdk1.4.2_14
3. Setthe JAVA_HOME as Windows environment variable

For example: JAVA_HOME=C:\j2sdk1.4.2_14
4. Add an entry for JDK path in the PATH environment variable

For example: PATH = %PATH%;C:\j2sdk1.4.2_14\bin

Creating the Agile PLM Datamart Database on Windows

To create the Agile Datamart database on Windows:
1. Unzip AntDBScripts.zip.

2. Go to InstallerScripts folder under AntDBScripts folder and configure WinDBInstaller.properties at
/AntDBScripts/InstallerScripts/WinDBInstaller.properties according to the OPTION you select, viz., 1,
2, 3, 4. See below.

Options

Specify the option for the following
# 1. Creates new instance, new tablespaces
# 2. Use existing instance, creates new tablespaces
# 3. Use existing instance, existing tablespaces

# 4. Replaces tokens in all SQL files
OPTION =1

# Specify DB Type if you choose OPTION=1 and OPTION =2, Otherwise no need. Options are
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[Small/Medium/Large]

DB _TYPE = Large
# Specify Oracle version [10g/9i] if you choose OPTION=1 and OPTION=2 and OPTION=3,
Otherwise no need.

ORACLE_VERSION = 10g

# This is the folder where the source code is unzipped [Specify this for all options]
DBFILES ORIG LOCATION = D:/Database

# This is Insatll directory where The original source files get copied to. [Specify this for all options]
DBFILES COPY LOCATION = D:/Database/Analyticstmp

# Specify Character Set if you choose OPTION=1.Otherwise no need.
CharecterSet = UTF8

# Database Instance Name. Otherwise no need.

DB _SID = AADM
# Password for User AAD (Administration Schema) which gets created during installation. Specify
this for all options.

AAD PASSWORD = aad
# Password for User AST (Staging Schema) which gets created during installation. Specify this for
all options.

AST PASSWORD = ast
# Password for User ADW (Datamart Schema) which gets created during installation. Specify this
for all options.

ADW_PASSWORD = adw

# Specify ORACLE_HOME directory [Specify this for all options]
ORACLE HOME = D:/oracle/product/10.1.0/Db 1

# sys user password [Specify this for all options]
ORACLE INTERNAL USER PASSWORD = oracle

# system user password. [Specify this for all options]
ORACLE_SYSTEM USER PASSWORD = manager

# These are the file folder paths where respective table space data files have to be created

# Make sure that you create a folder with Database instance name (ex: AADM) in the respective
folders

# include forward slash "/" at the end of folder path

# This is for System Table space and SYSAUX Table space files if you choose OPTION=1.
Otherwise no need.

SYSTEM_FILE LOCATION = D:/oracle/product/10.1.0/oradata/
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# This is for Redo Log files if you choose OPTION=1.0therwise no need.
LOGFILE LOCATION = D:/oracle/product/10.1.0/oradata/

# This is for Temporary Table space files if you choose OPTION=1. Otherwise no need.
TEMPFILE LOCATION = D:/oracle/product/10.1.0/oradata/

# This is for Control files if you choose OPTION=1. Otherwise no need.
CONTROLFILE LOCATION = D:/oracle/product/10.1.0/oradata/

# This is for Undo Table space files if you choose OPTION=1. Otherwise no need.
UNDOFILELOCATION = D:/oracle/product/10.1.0/oradata/

# This is for Datamart Table space files if you choose OPTION=1. Otherwise no need.
DATAFILE LOCATION = D:/oracle/product/10.1.0/oradata/

# Specify no. of tablespaces (Both data and index) if you choose OPTION=1 and OPTION=2,

Otherwise no need.
NO OF TABLESPACES = 15

# Specify the new TS names to be created if you choose OPTION=1 and OPTION=2. Otherwise no

need.
TS1

AGILE_DATA1

TS2 = AGILE DATA2

TS3 = AGILE DATA3

TS4 = AGILE_ INDX1

TS5 = AGILE AAD DATAL

TS6 = AGILE ADW DATAL

TS7 = AGILE_ADW DATA2

TS8 = AGILE ADW DATA3

TS9 = AGILE ADW DATA4

TS10 = AGILE_ADW DATAS5
TS11 = AGILE _ADW DATA6
TS12 = AGILE ADW INDX1
TS13 = AGILE STG DATAl
TS14 = AGILE STG DATA2
TS15 = AGILE STG DATA3

# Update table space size in Small/Medium/Large.properties file for corresponding DB_TYPE if you

choose OPTION=1 and OPTION=2. Otherwise no need.

# Specify the Datafile name for new TableSpace if you choose OPTION=1 and OPTION=2.

Otherwise no need.
TS1 DATAFILENAME = AGILE DATAl
TS2 DATAFILENAME = AGILE DATA2
TS3 DATAFILENAME = AGILE DATA3
TS4 DATAFILENAME = AGILE INDX1
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TS5 DATAFILENAME
TS6_DATAFILENAME
TS7_ DATAFILENAME
TS8 DATAFILENAME
TSS9 DATAFILENAME
TS10_ DATAFILENAME
TS11 DATAFILENAME
TS12 DATAFILENAME
TS13_ DATAFILENAME
TS14 DATAFILENAME
TS15 DATAFILENAME

AGILE_AAD DATA1
AGILE ADW DATA1
AGILE_ADW_DATA2
AGILE_ADW_DATA3
AGILE_ADW DATA4
AGILE_ADW DATAS
AGILE_ADW DATA6
AGILE_ADW_INDX1
AGILE_STG DATA1
AGILE_STG DATA2
AGILE_STG DATA3

# Mapping of Table spaces to DM Tablespaces [Specify this for all options]
AGILE DATAL
AGILE DATA2

AGILE DATAl
AGILE_DATA2

AGILE_DATA3 = AGILE DATA3
AGILE INDX1 = AGILE INDX1

AGILE_AAD DATA1
AGILE_ADW DATA1
AGILE_ADW_DATA2
AGILE_ADW_DATA3
AGILE_ADW DATA4
AGILE_ADW_DATAS
AGILE_ADW DATA6
AGILE_ADW_ INDX1
AGILE STG DATAl
AGILE_STG DATA2
AGILE_STG DATA3

AGILE_AAD DATA1
AGILE_ADW DATA1
AGILE_ADW_DATA2
AGILE_ADW_DATA3
AGILE_ADW DATA4
AGILE_ADW_DATAS
AGILE_ADW DATA6
AGILE_ADW_INDX1
AGILE STG DATAl
AGILE_STG DATA2
AGILE_STG DATA3

Steps to run database creation file

1.
2.
3.

Go to <DBFILES_ORIG_LOCATION>/AntDBScripts/InstallerScripts
Run WinAnt_Installer.bat

Log files are created in the following location
<DBFILES_COPY_LOCATION>/Windows/Logs
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Chapter 4
PLM Data Coverage

This chapter includes the following:

(O 1YL=
Class Attributes - Summary
ClasS ALHDULES = COMIMON......c.viviuiiietiiitei sttt sttt et s b e st st s e st et e st st et st ese st e b e st st st st e st seesssbe st st ess st abe st sbe e atns
Class Attributes - PC ..o

ClASS ATITDULES = PPM....eceiiceiecs ettt sttt st sttt et b s bt sttt s b e et e et e bs st b et abe et e
Class ALTDUIES = PQM ....c.vuiiciiciiiisceie ettt st en bbb bbbt n et enas

Overview

Agile PLM Analytics Datamart is a modular product that can be configured to Load Data from PC,
PQM and PPM modules by enabling corresponding Licenses. The following tables give you the
extent of Data coverage configured in the current release of Agile PLM Datamart.
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Class Attributes - Summary

Module Base Class Class
Change Orders
Change Requests
Change Deviations
Manufacturer Orders
Site Change Orders
Stop Ships
Common Customers Customer
File folders File folders
lems Documents
Parts
Suppliers Suppliers
User Groups User Groups
Users users
Manufacturer Parts Manufacturer Parts
PC Manufacturers Manufacturers
Sites Sites
PSR Non-conformance Reports
PQM Proplem Reports
QCR Audits
Corrective & Preventive Actions
Programs Activites
PPM Gates
Discussions Discussions
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Class Attributes - Common
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Base Class Class Tab Attributes Datamart
Changes, Change Orders Title Block Cover page atributes P (-
el Change Requests Page Two P2 & Infinite flex T es

Deviations Page Three P3 & Infinite flex Yes
Manufacturer Orders Affected ltem Standard atributes Yes
Site Change Orders Affected Item | P2 atiributes on Affected Item tab No
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Base Class Class Tab Attributes Datamart
Suppliers, Supplier Title Block Cover page atributes P (-~
el Page Two P2 & Infinite flex T T e

Page Three P3 & Infinite flex Yes
ContactUsers |Standard attributes No

RFx Routing  Standard atributes No
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Class Attributes - PC

Base Class Class
Manufacturer Parts Manufacturer Parts
Manufacturers
Sites Sites

Tab
Tite Block
Page Two
Page Three
Suppliers
Suppliers
Where Used
Attachments
History
Tite Block
Page Two
Page Three
Attachments
History

Attributes
Cover page atributes
P2 & Infinite flex
P3 & Infinite flex
Standard attributes
P2 atributes
Standard atributes
Standard attributes
Standard attributes
Cover page atributes
P2 & Infinite flex
P3 & Infinite flex
Standard attributes
Standard attributes

Datamart
Yes
Yes
Yes

No
No
No
No
No
Yes
Yes
Yes
No
No
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Class Attributes - PPM

Base Class
Programs

Programs

Class
Activiies

Gates

Tab
Tite Block
Page Two
Page Three
Schedule
Dependencies
Team
Team
Deliverables
Deliverables
Deliverables
Relationships
Links
Workflow
Workflow
Discussion
Discussion
Discussion
Attachments
Attachments
History
Tite Block
Page Two
Page Three
Dependencies
Approval Items
Approval Items
Team
Team
Deliverables
Deliverables
Deliverables
Relationships
Links
Links
Workflow

Attributes
Cover page atributes
P2 & Infinite flex
P3 & Infinite flex
Standard atrributes
Standard attributes
Standard attributes
P2 atributes
Standard atrributes
P2 atributes on Affected by table
P2 attributes on Affects table
Relationships
P2 atributes
Standard attributes
P2 atributes
Discussion
Action Item standard atrributes
Action Item P2 attributes
Standard attributes
P2 atributes
Standard attributes
Cover page atributes
P2 & Infinite flex
P3 & Infinite flex
Standard attributes
Standard attributes
P2 atributes
Standard atrributes
P2 atributes
Standard attributes
P2 attributes on Affected by table
P2 atributes on Affects table
Relationships
Standard attributes
P2 atributes
Standard atrributes

Datamart
Yes
Yes
Yes

No
No
Yes
No
Yes
No
No
No
No
Yes
No
Yes
Yes
No
Yes
No
No
Yes
Yes
Yes
No
Yes
Yes
Yes
No
Yes
No
No
No
Yes
No
Yes
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Class Attributes - PQM

Base Class Class
Problem Service Requests |Problem Reports
Non conformance reports

Quality Change requests  Corrective & Preventve action
Audits

Tab
Title Block
Page Two
Page Three
Affected Item
Affected Item
Affected Item
Workflow
Relationships
Relationships
Relationships
References
References
Attachments
Attachments
History
Title Block
Page Two
Page Three
Affected Item
Affected ltem
Affected Item
Workflow
Relationships
Relationships

Attributes
Cover page atributes
P2 & Infinite flex
P3 & Infinite flex
Standard attributes
P2 atributes on Affected Item tab
Read through atfributes on Affected Item tab
Standard atrributes
Standard attributes
P2 atributes on Affected by table
P2 atributes on Affects table
Standard atrributes
P2 atributes on References tab
Standard attributes
P2 atributes
Standard attributes
Cover page atributes
P2 & Infinite flex
P3 & Infinite flex
Standard attributes
P2 atributes on Affected Item tab
Read through atributes on Affected Item tab
Standard attributes
Standard attributes
P2 atributes on Affected by table

Datamart
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

No
No
No
No
No
No
No
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
No
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Chapter 5
List Attributes Configuration

This chapter includes the following:

S oo oL T OSSOSO PP SPOPOTOTTTRTPTOON 43
= Business rules for configuring the XML ........ccceeeriiirnice s ssssssesssesssnes 43
Scope

Whenever Agile PLM is customized for List Attributes, the ListAttributes.xml (found at
<AA HOME>\Analytics\config\Common) will need to be reconfigured. Follow the rules given below

to configure this file.

Business rules for configuring the XML

1. Multiple Dimension Tables can be created for the same List

Irrespective of the class and Attribute_Id, when the List_Id is same, you can map a List
Attribute to different Table_Name.

Example

<List Table Attrib Name="Workflow" Attribute Id="3742" List Id="3641"
Table Name="WORKFLOW_ADW_PC_DIM" />

<List Table Attrib Name="Workflow" Attribute Id="4868"List Id="3641"
Table Name="WORKFLOW_ADW_PQM_DIM" />

Here, List_Id "3641" is mapped to two different tables - WORKFLOW_ADW_PC_DIM and
WORKFLOW_ADW_PQM_DIM.

2. Multiple Lists cannot be mapped to the same Dimension Table

Mapping multiple Lists to same Dimension Table leads to XML Configuration Error as different
List_Id cannot point to the same Table_Name. This is because every list dimension table
contains single list value.

The following, for example, is incorrect -

<List Table Attrib Name="Workflow" Attribute Id="3742" List Id="3641"
Table Name="WORKFLOW_ADW_PC_DIM" />

<List Table Attrib Name="Workflow" Attribute Id="4868"List Id="5482"
Table Name="WORKFLOW_ADW_PC_DIM” />

Incorrect configuration will lead to abortion of the task and the following error message -
common.P1ListAttibuteXMLValidator:validate [ERROR] Configuration Error: Cannot re-
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Changing default List_Id to a new List_Id

1.

Map ListID: 5482 to TableName: WORKFLOW_ADW_PC_DIM. This table already

mapped with listID :3641

Logfile name - CoverPageListDimensionCreator.log

Table_Name should NOT be the any of the following, as these are OOTB (Out-of-the-box) Dimension Tables

COMDTY ADW_COM_DIM
CTGRY ADW_COM DIM
CUST ADW_COM DIM
DISP_ADW_PQM DIM
FMODE_ADW_PQM DIM
LFCYL,_ADW _COM DIM
ORIGTR_ADW_PQM DIM
PRDLINE_ADW COM DIM
QANLYST ADW PQM DIM
SEV_ADW_PQM DIM
SUPP_ADW_COM_DIM
WKFLW_ADW_COM_DIM

If any of these tables are configured in ListAttributes.xml file, the task will abort, displaying the

following error message -

common.P1ListAttibuteXMLValidator: validate [ERROR] Configuration Error:
COMDTY_ADW_COM_DIM :is OOTB Dimension table. Use different table name in the

XML

Logfile name - CoverPageListDimensionCreator.log

Changing default List_Id to a new List_Id

Whenever you change the List value of an Attribute in Agile PLM, you are required to reconfigure the

ListAttributes.xml file.

If the List of an Attribute has been changed to point to another List, you will need to enter the

List_Id of new List, manually.

Example
Original Configuration
<List_ Table

Attrib Name="Workflow"
Attribute Id="3742"

List Id="3641"

Table Name="WORKFLOW ADW PC DIM" />

Configuration changes required
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<List Table
Attrib Name="Workflow"
Attribute Id="3742"
List Id="84256"
Table Name="WORKFLOW ADW PC DIM" />

In PLM, the workflow attribute points to the list attribute 3641 by default. If attribute is
reconfigured with list id 84256 then this change should be made in XML also (manually). If you
don't do so, the following error message will be displayed in the log

common.P1ListAttibuteXMLValidator:validate [ERROR] Please Check ListAttributes.xml: In
PLM the Class: Activities, Attibute id: 3742 is assigned with the List Id: 84256.

Logdfile name - CoverPageListDimensionCreator.log

The table WORKFLOW_ADW_PC_DIM will be created with default value. In this case task will
not abort.

2. Before changing the XML you need to focus on the following
* The Class that needs to be changed
® The Attribute whose List_Id will be changed

Consider the table name if it is assigned with the previous List_Id (3641) in some other attribute
in the XML then we should use the new table nhame

Example

Before change
Attribute_Id: 3742 List_Id: 3641 O WORKFLOW_ADW_PC_DIM
Attribute_Id: 7458 List_Id: 3641 [0 WORKFLOW_ADW_PC DIM
After change the List_Id for Attribute_Id 3742

Wrong configuration
Attribute_Id: 3742 List_Id: 84256 [ WORKFLOW_ADW_PC_DIM
Attribute_Id: 7458 List_Id: 3641 O WORKFLOW_ADW_PC _DIM

Now new list id 84256 mapped with WORKFLOW_ADW_PC_DIM and list id 3641 also mapped with
WORKFLOW_ADW_PC _DIM. This will lead the configuration error. In this situation we should
provide the different table name for the newly assign list id;

Correct configuration
Attribute_Id: 3742 List_Id: 84256 [ WORKFLOW_1_ADW_PC_DIM
AttributelD: 7458 List_Id: 3641 O WORKFLOW_ADW_PC_DIM

Make sure that WORKFLOW1_ADW_PC_DIM table name not mapped with some other list id.

Disabling the Dimension Table from being created

1. Ifyou disable an attribute in PLM, then the corresponding attribute tag needs to be commented out in the
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XML

Example

If you disable the attribute Workflow in Class_Name "Manufacturer Orders" then comment the
corresponding tag in XML as following

<Class Class_ Name="Manufacturer Orders" Class Id="1450">

<List Table

Attrib Name="Product Line(s)"
Attribute Id="1003"

List Id="291"

Table Name="PRDLINE ADW PC DIM" />

<List Table

Attrib Name="Change Type"

Attribute Id="1069"

List Id="1450"

Table Name="CHANGE TYPE ADW PC DIM" />

<List Table

<! --

List Id="3641" Table Name="WORKFLOW ADW PC DIM" /> --- >

Attrib Name="Originator"

Attribute Id="1050"

List Id="361"

Table Name="ORIGINATOR ADW PC DIM" />

<List Table

Attrib Name="Component Engineer"
Attribute Id="1480"

List Id="750"

Table Name="COMP ENGINEERS ADW PC _DIM" />

<List Table

Attrib Name="Status"

Attribute Id="1030"

List Id="733"

Table Name="STATUS ADW PC_DIM" />

<List Table

Attrib Name="Change Category"
Attribute Id="1060"

List Id="411"

Table Name="CTGRY ADW PC DIM" />

<List Table Attrib Name="Workflow" Attribute Id="3742"
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<List Table
Attrib Name="Reason Code"
Attribute Id="1049"
List Id="351"
Table Name="REASONCODE ADW PC DIM" />

</Class>

If this configuration is not incorporated in XML, the following error message will be displayed in
the log

common.P1ListAttibuteXMLValidator:validate [ERROR] Please Check ListAttributes.xml: In

PLM the Class: Manufacturing Order, Attribute Id: 3742 is disabled, Please reconfigure
ListAttributes.xml

Logfile name - CoverPageListDimensionCreator.log

The WORKFLOW_ADW_PC_DIM table will be created with default value. Task will not abort.
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Chapter 6
Datamart Administration

This chapter includes the following:

Overview of Agile PLM Datamart AAMINISIFAtioN.........ccocevieinneeiiiess e sss s essssessssssessssssesesssesnns 49
Configuring Custom Agile PLM Fields
SUMMATY TADIES ... ettt s s bbbttt
Turning ON the ADVPA TaskS ........ccooerrevreennes

TUNING OFF the ADVPA TASKS. ......cuiitieiriieeisieieirt ettt bbb
Configuring Page 2 & Page 3 for Agile PC, PPM & PQM........ccccoeiiiiniieininsisncss s sssssssss s sssssennns
Using DT/Studio to Run Agile PLM Datamart ETL Scripts
How Your Agile License Key AffECtS ETL TASKS ....v.ccvveiurieeiieesirssisissssessssssess s sssssssssssessssssssssssssssssnsessssseens
Changing the Datamart PASSWOIT...........ueurirriirririeeirisessee et sese st sssessssnsesnes
Changing the DT/ENGINE PASSWOIT. .........cururiieuriireireeieisietsireseis sttt eb bbb
Changing the DT/ENgiNg REPOSItOrY PASSWOI ........ccccuiiieiinieieiieisisetss s ese s esssse s ssssssssssssessssennns

Overview of Agile PLM Datamart Administration

Agile PLM Datamart administration is fairly straightforward, mainly because the Agile PLM Datamart
database is a separate database that must be maintained and administered separately from the
Agile PLM server. For effective use of Agile PLM Datamart, data must be extracted from the Agile
PLM server, transformed, and loaded to the Agile PLM Datamart database on a regular basis. The
Agile PLM Datamart includes DT/Studio, an ETL engine from Embarcadero Technologies, to
manage the ETL process.

Configuring Custom Agile PLM Fields

Users with Administrator privileges can configure custom fields on Page Two and Page Three for
any Agile PLM subclass. Data for enabled Cover Page, Page Two, and Page Three attributes is

loaded into flattened summary tables in the Agile PLM Datamart. These summary tables use the
naming convention XXX_XXX_CDW_SUM.

A separate summary table is created for each subclass. If you subsequently enable or disable
attributes on the Cover Page, Page Two, or Page Three, when you run the ETL tasks again they
automatically create a new summary table to reflect your changes.

Summary Tables

When you run the Agile Analytics task chain in DT/Console, it runs an ETL task called
COM_CREATE_ADW_COM_SUM that retrieves metadata from the Agile PLM server and creates a
configuration file called Configuration.xml in the root:\..\config\Common folder. After that, the ETL task
then uses information from the Configuration.xml file to execute DDL SQL commands that create the
summary tables on the Datamart.
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Since a separate summary table is created for each subclass, there is a performance hit for each
subclass of data that must be loaded into the Datamart. It is advisable to disable data extraction on
subclasses that you do not want loaded into the Datamart by modifying the Configuration.xml file.
Similarly, the attributes that are not required for data extraction can also be disabled.

If you modify the Configuration.xml file, you will need to exclude the ETL task
COM_CREATE_ADW_COM_SUM from the task chain. Otherwise, the
COM_CREATE_ADW_COM_SUM task will generate a new Configuration.xml file, overwriting the
one you modified.

Turning ON the Summary Table Creation

To turn ON the Summary table creation for a fresh ETL installation:
1. Ensure that Agile PLM Datamart tasks are installed.
2. Stop the DT/Engine service.

3. Modify the adw_com_datasource.properties file and adw_com_taskchain.list files (the default path is
<AA_Home>\ETL\Common\) by adding the following tasks to the end of the task chain:

,COM_CREATE_ADW_COM_SUM,COM_LOAD_ADW_COM_SUM
4. Restart the DT/Engine service.

5. Start the Agile Analytics task chain through DT/Console.

To turn ON the Summary table creation after at least one ETL run:

1. Ensure that Agile PLM Datamart tasks are installed.

2. Stop the DT/Engine service.

3. Add the following tasks to the task chain:
COM_CREATE_ADW_COM_SUM
COM_LOAD_ADW_COM_SUM

4. Modify the adw_com_datasource.properties file and adw_com_taskchain.list files (the default path is
<AA_Home>\ETL\Common\) by adding the following tasks to the end of the task chain:

,COM_CREATE_ADW_COM_SUM,COM_LOAD_ADW_COM_SUM

5. Copy the COM_CREATE_ADW_SUM.xml and COM_LOAD_ADW_COM_SUM.xml files from the
<AA_Home>\ETL\Common|templatexmls folder into the <DT_Home>\storage folder.

6. Restart the DT/Engine service.
Run the following tasks from DT/Console in the specified order:
* COM_PRE_TASK
* COM_CREATE_ADW_COM_SUM
* COM_LOAD_ADW_COM_SUM
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Turning OFF the Summary Table Creation

To turn OFF the Summary table creation:
1. Ensure that Agile PLM Datamart tasks are installed.
2. Stop the DT/Engine service.

3. Modify the adw_com_datasource.properties file and adw_com_taskchain.list files (the default path is
<AA_Home>\ETL\Common\) by removing the following tasks from the task chain:

,COM_CREATE_ADW_COM_SUM,COM_LOAD_ADW_COM_SUM
Restart the DT/Engine service.

Log in to DT/Console and delete COM_CREATE_ADW_COM_SUM and COM_LOAD_ADW_COM_SUM
from the tasks.

6. Start the Agile Analytics task chain through DT/Console.

Turning ON the ADVPA Tasks

Note Before you begin, please ensure that the DT/Engine is running.

1. Go to the folder <AA HOME>\ETL\
2. Run UninstallAgileTasks.bat to un-install all the Tasks & Task Chains

3. Open InstallAgileTasks.py in a word editor
a. Delete the entry - PA_PCA PQA PAEXT TaskChain.xml
b. Add a new entry - PAEXT_PA RPM_PCA_PQA_TaskChain.xml

4. Copy the following files to <DT_HOME>\Storage\

File Location File Name

<AA_HOME>\ ETL\Staging\Common\templatexmls PLM_AST _COM_ALL.xml
<AA_HOME>\ ETL\Staging\PA\templatexmls PLM_AST_PA ALL.xml
<AA_HOME>\ ETL\Staging\PCA\templatexmls PLM_AST _PCA ALL.xml
<AA_HOME>\ ETL\Staging\PQA\templatexmls PLM_AST_PQA_ALL.xml
<AA_HOME>\ ETL\PA\templatexmls PLM_ADW_PA_ALL.xml
<AA_HOME>\ ETL\PCA\templatexmls PLM_ADW_PCA_ALL.xml
<AA_HOME>\ ETL\PQA\templatexmls PLM_ADW_PQA_ALL.xml
<AA_HOME>\ ETL\Common\templatexmls PLM_ADW_COM_ALL.xml
<AA_HOME>\ ETL\Common\templatexmls PLM_AA POST_TASK.xml
<AA_HOME>\ ETL\ADVPA\templatexmls PLM_ADW_ADVPA_ALL.xml
<AA_HOME>\ ETL\PA_EXT\templatexmls PLM_ADW_PA EXT_ALL.xml

5. Run InstallAgileTasks.bat located at AA_ HOME\ETL
6. Make sure isFullLoad and initialize properties are set to "1" in all of the following files

File Location File Name
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<AA _HOME>\ ETL\Staging\Common ast_com_custom.properties
<AA_HOME>\ ETL\Staging\PA ast_pa_custom.properties
<AA_HOME>\ ETL\Staging\PCA ast_pca_custom.properties
<AA_HOME>\ ETL\Staging\PQA ast_ga_custom.properties
<AA_HOME>\ ETL\Common adw_com_custom.properties
<AA HOME>\ ETL\PA adw_pa_custom.properties
<AA HOME>\ ETL\PCA adw_pca_custom.properties
<AA_HOME>\ ETL\PQA adw_pga_custom.properties
<AA _HOME>\ ETL\PA EXT adw_pa_ext_custom.properties
<AA_HOME>\ ETL\ADVPA dw_advpa_custom.properties

Make sure AA_HOME\ETL\Staging\Recoverylogic.properties file has the entry CanRunAST =1
Restart DT Engine Manager Service
Login to DTEngine through DTConsole

10. Start Agile Analytics task chain

Turning OFF the ADVPA Tasks

Note Before you begin, please ensure that the DT/Engine is running.

1. Go to the folder <AA_ HOME>\ETL\
2.  Run UnlinstallAgileTasks.bat to de-deploy the Tasks & Task Chains

3. Open InstallAgileTasks.py in a word editor
a. Remove the entry - PAEXT_PA_RPM_PCA PQA_TaskChain.xml
b. Add the entry - PA_PCA PQA PAEXT_ TaskChain.xml

4. Copy the following files to <DT_HOME>\Storage\

File Location File Name

<AA_HOME>\ ETL\Staging\Common\templatexmls PLM_AST_COM_ALL.xml
<AA HOME>\ ETL\Staging\PA\templatexmls PLM_AST_PA ALL.xml
<AA_HOME>\ ETL\Staging\PCA\templatexmls PLM_AST_PCA ALL.xml
<AA_HOME>\ ETL\Staging\PQA\templatexmls PLM_AST PQA_ALL.xml
<AA_HOME>\ ETL\PA\templatexmls PLM_ADW_PA_ALL.xml
<AA_HOME>\ ETL\PCA\templatexmls PLM_ADW_PCA_ALL.xml
<AA _HOME>\ ETL\PQA\templatexmls PLM_ADW_PQA ALL.xml
<AA_HOME>\ ETL\Common\templatexmls PLM_ADW_COM_ALL.xm|
<AA_HOME>\ ETL\Common\templatexmls PLM_AA POST TASK.xml
<AA_HOME>\ ETL\PA_EXT\templatexmls PLM_ADW_PA_EXT_ALL.xml
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5. Run InstallAgileTasks.bat located at AA_ HOME\ETL

6. Make sure isFullLoad and initialize properties are set to "1" in all of the following files

File Location File Name

<AA_HOME>\ ETL\Staging\Common ast_com_custom.properties
<AA_HOME>\ ETL\Staging\PA ast_pa_custom.properties

<AA HOME>\ ETL\Staging\PCA ast_pca_custom.properties
<AA HOME>\ ETL\Staging\PQA ast_ga_custom.properties
<AA_HOME>\ ETL\Common adw_com_custom.properties
<AA_HOME>\ ETL\PA adw_pa_custom.properties
<AA_HOME>\ ETL\PCA adw_pca_custom.properties
<AA HOME>\ ETL\PQA adw_pga_custom.properties
<AA HOME>\ ETL\PA EXT adw_pa_ext_custom.properties

7. Make sure AA HOME\ETL\Staging\Recoverylogic.properties file has the entry CanRunAST =1
8. Restart DT Engine Manager Service

9. Login to DTENngine through DTConsole

10. Start Agile Analytics task chain

Configuring Page 2 & Page 3 for Agile PC, PPM & PQM

This section provides general examples of the Extnfields.xml file. Contact Agile for specific
requirements.

Before configuring the Extnfields.xml file, you should:
@ Have good understanding of the JavaClient.
@ Know the dimension and measure fields for the P2 and P3 attributes.

Configuring Page 2 and Page 3 for your Agile Analytics - PC, PPM & PQM environment requires
customizing the PCExtnfields.xml, PPMExtnfields.xml & Extnfields.xml files, respectively. These files are
required to create the extension tables in the Datamart, which in turn help create the corresponding
materialize views.

Important If the table names are not provided, the task will fail.

Tables

PC PPM PQM
CHNG_ADW_EXT FCT ACT_ADW_EXT_FCT PSR_ADW_EXT DIM
CHNG_ADW_EXT DIM ACT_ADW_EXT_DIM PSR_ADW_EXT FCT

QCR_ADW_EXT_DIM
QCR_ADW_EXT_FCT
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Obtaining Class and Subclass IDs

When configuring XML you need the class ID (for Page 2 attributes) and subclass ID (for Page 3
attributes). This information is available only in the source database and does not readily appear in
the Java client.

To obtain the class ID and subclass ID:

1. Login into the Java client.

2. Click the Admin tab, then select Data Settings > Classes.

3. Double-click on Classes.

4. Copy the name and replace it with <Class_Name> in the query.

Query to get Class ID
SELECT ID,NAME FROM nodetable WHERE description LIKE '<Class_ Name>'

Query to get Subclass ID

SELECT ID, NAME FROM nodetable WHERE parentid IN (SELECT ID FROM
nodetable WHERE parentid IN (SELECT ID FROM nodetable WHERE
description LIKE '<Class Name>') AND objtype = 14

Example for classid
SELECT ID,NAME FROM nodetable WHERE description LIKE 'Problem Reports'

Example for Subclassid

SELECT ID, NAME FROM nodetable WHERE parentid IN (SELECT ID FROM
nodetable WHERE parentid IN (SELECT ID FROM nodetable WHERE
description LIKE 'Problem Reports') AND objtype = 14)

5. Execute queries on the source database to get the ClassID and SubclassID (in the format
<username>/ <password>@<ORACLE_SID>, the default is agile/tartan@agile9).

Page 2 & Page 3 XML Structure
PC

You need to configure the PCExtnfields.xml file for Page 2 and Page 3. This file is located in
<AA _Home>/config/PCA folder
<?xml version="1.0" encoding="UTF-8"?>
<ExtnFields version="1.0" timestamp="Thu Jun 14 11:40:38 IST 2007" Enable="Y">
<CHNGFields
FetchCount="5000"
BatchCount="1000"
StagingTableName ="CHANGES_AST_COM"
StagingFlexTableName ="CHANGES_AST_COM_FLX"
DatamartFactTableName ="CHNG_ADW_EXT_FCT"

Page - 54 Datamart Setup Guide



Chapter 6

DatamartDimensionTableName ="CHNG_ADW_EXT_DIM">
</CHNGFields>

</ExtnFields>

PPM
You need to configure the PPMExtnfields.xml file for Page 2 and Page 3. This file is located in
<AA_Home>/config/PA folder.
<?xml version="1.0" encoding="UTF-8"?>
<ExtnFields version="1.0" timestamp="Thu Jun 14 09:24:57 IST 2007" Enable="Y">
<PRGFields
FetchCount ="5000" BatchCount ="1000"
StagingTableName ="ACT_AST_PPM"
StagingFlexTableName ="ACT_AST_PPM_FLX"
DatamartFactTableName ="ACT_ADW_EXT_FCT"
DatamartDimensionTableName ="ACT_ADW_EXT_DIM">
</PRGFields>
</ExtnFields>
PQM
You need to configure the PCExtnfields.xml file for Page 2 and Page 3. This file is located in
<AA_Home>/config/Common folder
<?xml version="1.0" encoding="UTF-8" ?>
<ExtnFields version="1.0" timestamp="2004-01-30T18:30:00 PDT" Enable="Y">
<PSRFields
FetchCount="5000"
BatchCount="1000"
StagingTableName="PRODUCT_SERVICE_REQUES_AST_PQM"
StagingFlexTableName="PRODUCT_SERVICE_RE_AST PQM_FLX"
DatamartFactTableName="PSR_ADW_EXT_FCT"
DatamartDimensionTableName="PSR_ADW_EXT_DIM">
</PSRFields>
<QCRFields
FetchCount="5000"
BatchCount="1000"
StagingTableName="QUALITY_CHANGE_REQUEST_AST_PQM"
StagingFlexTableName="QUALITY_CHANGE_REQ_AST_PQM_FLX"
DatamartFactTableName="QCR_ADW_EXT_FCT"
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DatamartDimensionTableName="QCR_ADW_EXT_DIM">

</QCRFields>
</ExtnFields>

Where:
FetchCount
BatchCount
StagingTableName
StagingFlexTableName

DatamartFactTableName

DatamartDimensionTableName =

= Minimum value: 1000, maximum value: 5000

= Minimum value: 1000, maximum value: 2000

=  Staging tablename located in the staging database

=  Staging tablename located in the staging database

= Extension fact table tablename

Extension dimension table tablename

Page 2 & Page 3 String Structures

Page 2 String Structure
<ExtnField
ID=""
Attributeld=""

DataMartColumnName=""

isMeasure=

isDimension=
Listld=""

ListName=

PageType=

DataType=

Length=

ListTableName=""/>

Page 3 String Structure
<ExtnField
ID=""
SubClassld=""
Attributeld=""

DataMartColumnName=

isMeasure=

isDimension=
Listld=""

ListName=

PageType=

DataType=

Length=

ListTableName=""/>

Where:

ID = ClassID

SubClassld = The subclass ID of the specified attribute. For Page 3 only.

Attributeld = The BaselD value available in JavaClient.
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DataMartColumnName For a table, all column names should be unique following Oracle column naming standards.
All column names can contain only characters, numbers, and underscores. No special

characters are allowed.

isMeasure = YesorNo
isDimension = YesorNo
Listld = All list attributes should be correctly mentioned, as per JavaClient.
ListName = The name you want to appear with the data, as per JavaClient.
PageType = P2orP3
DataType = Attribute Type Data Type Max. Length
Text VARCHAR2 255
List VARCHAR2 255
Multilist VARCHAR2 4000
Multitext VARCHAR2 4000
Headings VARCHAR?2 510
Money Money 38.6*
Numeric Number 38.6*
Date VARCHAR2 255
Length = The maximum number of characters expected from DataType.
ListTableName = Used to create a table for all list attributes.

For two different list attributes with the same ListID and with two different list table
names given, two dimension tables are created and one table if we have give same
table name or both the list attributes. Or this depends on the configuration.

* For Money and Numeric attribute types, the maximum length supports 38 characters,
six of which can be to the right of the decimal.
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Sample Configured Strings

Page 2
<ExtnField
ID="4878"
Attributeld="2002"
DataMartColumnName="DATE_PAGETWOQO"
isMeasure="YES"
isDimension="YES"
Listld=""
ListName=""
PageType="P2"
DataType="VARCHAR2"
Length="255"

ListTableName=""/>

<ExtnField
ID="4878"
Attributeld="30445"
DataMartColumnName="MULTILIST _PAGETWOQO"
isMeasure="YES"
isDimension="YES"
Listid="2000000108"
ListName="Launch Year List"
PageType="P2"
DataType="VARCHAR2"
Length="4000"
ListTableName="LAUNCHYEAR_DIM"/>

Page 3

Note Page 3 fields must include the Subclass ID.

<ExtnField
ID="4878"
Attributeld="2021"
DataMartColumnName="LIST_PAGE_TWO"
isMeasure="YES"
isDimension="YES"
Listld="12868"
ListName="Priority"
PageType="P2"
DataType="VARCHAR2"
Length="255"
ListTableName="PRIORITY_DIM"/>

<ExtnField

ID="4878"

Attributeld="1313"

DataMartColumnName="TEXT_PAGETWO"

isMeasure="YES"

isDimension="YES"

Listld=""

ListName=""
PageType="P2"
DataType="VARCHAR2"
Length="255"

ListTableName="" />
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<ExtnField <ExtnField
ID="4878" ID="4878"
SubClassID="30126" SubClassID="30126"
Attributeld="1535" Attributeld="1544"
DataMartColumnName="DATE_PAGETHREE" DataMartColumnName="LIST _PAGETHREE"
isMeasure="YES" isMeasure="YES"
isDimension="YES" isDimension="YES"
Listld="" Listld="31073"
ListName="" ListName="Bom List"
PageType="P3" PageType="P3"
DataType="VARCHAR?2" DataType="VARCHARZ2"
Length="255" Length="255"
ListTableName=""/> ListTableName="BOMLIST_DIM"/>
<ExtnField <ExtnField
ID="4878" ID="4985"
SubClassID="30126" SubClassID="30199"
Attributeld="8154" Attributeld="1595"
DataMartColumnName="MONEY_PAGETHREE" DataMartColumnName="MULTILIST_PAGETHREE"
isMeasure="YES" isMeasure="YES"
isDimension="YES" isDimension="YES"
Listld="" Listld="6504"
ListName="" ListName="Severity"
PageType="P3" PageType="P3"
DataType="MONEY" DataType="VARCHAR2"
Length= "38,6" Length="4000"
ListTableName=""/> ListTableName="SEVERITY_DIM"/>

Sample XML Configuration for PQM

Place the configured PSR strings in between PSRFields as shown in the following example:
<?xml version="1.0" encoding="UTF-8" ?>
<ExtnFields version="1.0" timestamp="2004-01-30T18:30:00 PDT" Enable="Y">
<PSRFields
FetchCount="5000"
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BatchCount="1000"
StagingTableName="PRODUCT_SERVICE_REQUES_AST_PQM"
StagingFlexTableName="PRODUCT_SERVICE_RE_AST_PQM_FLX"

DatamartFactTableName="PSR_ADW_EXT_FCT"
DatamartDimensionTableName="PSR_ADW_EXT_DIM">

</PSRFields>

<!I-- Page 2 String -->
<ExtnField

ID="4878"
Attributeld="2002"

DataMartColumnName="DATE_PAGETWOQO"

isMeasure="YES"
isDimension="YES"
Listld=""
ListName=""
PageType="P2"
DataType="VARCHAR2"
Length="255"

ListTableName=""/>

<!I-- Page 3 String -->
<ExtnField

ID="4878"
SubClassID="30126"
Attributeld="1544"

DataMartColumnName="LIST _PAGETHREE"

isMeasure="YES"
isDimension="YES"
Listld="31073"
ListName="Bom List"
PageType="P3"
DataType="VARCHAR2"
Length="255"

ListTableName="BOMLIST_DIM"/>

<!-- Follow the previous steps to configure QCR strings by placing the configured QCR
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strings in between QCRFields as shown in the following example. -- >

<QCRFields

FetchCount="5000"
BatchCount="1000"

StagingTableName="QUALITY_CHANGE_REQUEST AST PQM"
StagingFlexTableName="QUALITY_CHANGE_REQ_AST PQM_FLX"

DatamartFactTableName="QCR_ADW_EXT_FCT"

DatamartDimensionTableName="QCR_ADW_EXT_DIM">
<!-- Page 2 -->
<ExtnField

ID="4428"
Attributeld="2002"

DataMartColumnName="DATE_PAGETWOQO"

isMeasure="YES"
isDimension="YES"
Listld=""
ListName=""
PageType="P2
DataType="VARCHAR2"
Length="255"

ListTableName=""/>

<!-- Page 3 -->
<ExtnField

ID="4428"
SubClassID="30199"
Attributeld="1595"

DataMartColumnName="MULTILIST_PAGETHREE"

isMeasure="YES"
isDimension="YES"
Listld="6504"
ListName="Severity"
PageType="P3"
DataType="VARCHAR2"
Length="4000"
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</QCRFields>
</ExtnFields>

ListTableName="SEVERITY_DIM"/>

Place the configured Extnfields.xml in the <AA_Home>/config/Common folder before starting the

AgileAnalytics Task chain.

Sample XML Configuration for PPM

Place the configured PPM strings in between PRGFields as shown in the following example:

PRGFields for PPM are available at <AA_HOME>\ config\PA\PPMExtnfields.xml
<?xml version="1.0" encoding="UTF-8" ?>
<ExtnFields version="1.0" timestamp="Thu Jun 14 09:24:57 IST 2007" Enable="Y">

<PRGFields

FetchCount="5000"

BatchCount="1000"
StagingTableName="ACT_AST_PPM"
StagingFlexTableName="ACT_AST PPM_FLX"
DatamartFactTableName="ACT_ADW_EXT_FCT"
DatamartDimensionTableName="ACT_ADW_EXT_DIM">

<!l-- Page 2 String -->
<ExtnField

ID="18022"

Attributeld="2002"
DataMartColumnName="DATE_PAGETWOQO"
isMeasure="YES"

isDimension="YES"

Listld=""
ListName=""
PageType="P2"
DataType="VARCHAR?2"
Length="255"

ListTableName=""/>

<!I-- Page 3 String -->
<ExtnField
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ID="18022"

SubClassID="30126"

Attributeld="1544"

DataMartColumnName="LIST _PAGETHREE"

isMeasure="YES"

isDimension="YES"

Listld="31073"

ListName="Bom List"

PageType="P3"

DataType="VARCHAR2"

Length="255"

ListTableName="BOMLIST_DIM"/>
</PRGFields>

</ExtnFields>

Place the configured PPMExtnfields.xml at <AA_HOME>\ config\PA folder before starting the
AgileAnalytics Task chain.

Sample XML Configuration for PC

Place the configured PC strings in between CHNGFields as shown in the following example:

CHNGFields for PC available at <AA_HOME>\ config\PCA\PCExtnfields.xml
<ExtnFields version="1.0" timestamp="Thu Jun 14 11:40:38 IST 2007" Enable="Y">
<CHNGFields
FetchCount="5000"
BatchCount="1000"
StagingTableName="CHANGES_AST_COM"
StagingFlexTableName="CHANGES_AST_COM_FLX"
DatamartFactTableName="CHNG_ADW_EXT_FCT"
DatamartDimensionTableName="CHNG_ADW_EXT_DIM">
<!I-- Page 2 String -->
<ExtnField
ID="6000"
Attributeld="2002"
DataMartColumnName="DATE_PAGETWOQO"
isMeasure="YES"

isDimension="YES"
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Listld=""
ListName=""
PageType="P2"
DataType="VARCHAR2"
Length="255"
ListTableName=""/>
<!-- Page 3 String -->
<ExtnField
ID="18022"
SubClassID="30126"
Attributeld="1544"
DataMartColumnName="LIST_PAGETHREE"
isMeasure="YES"
isDimension="YES"
Listld="31073"
ListName="Bom List"
PageType="P3"
DataType="VARCHAR2"
Length="255"
ListTableName="BOMLIST_DIM"/>
</CHNGFields>
</ExtnField>

Place the configured PCExtnfields.xml at <AA_HOME>\config folder before starting the
AgileAnalytics Task chain.

Configuring Affected [tems Page 2 for Agile PC & PQM

This section provides general examples of the Extnltmfields.xml file. Before configuring this file, you
should:

= have good understanding of the JavaClient.

o know the dimension and measure fields for the P2 attributes.

See Page 2 String Examples for Affected Items for information on obtaining class and subclass
IDs.

Configuring Page 2 for your Agile Analytics - PC & PQM environment requires customizing the
PCExtnitmfields.xml & Extnltmfields.xml files. These files are required to create the extension tables
in the Datamart, which in turn helps create the corresponding materialize views. If the table names
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are not provided, the task will fail.

Tables for PQM are
PSRITM_ADW_EXT_DIM
PSRITM_ADW_EXT_FCT
QCRITM_ADW_EXT_DIM
QCRITM_ADW_EXT_FCT

Tables for PC are
CHNGITM_ADW_EXT _DIM
CHNGITM_ADW_EXT_FCT

String Structure for Page 2 configuration

An example string for Page 2 appears as follows:

<ExtnField
ID=""
Attributeld=""

DataMartColumnName=

isMeasure=

isDimension=
Listld=""

ListName=

PageType=

DataType=

Length=

ListTableName=""/>

Where:

ID = ClassID

SubClassld = The subclass ID of the specified attribute. For Page 3 only.
Attributeld = The BaselD value available in JavaClient.

DataMartColumnName

isMeasure
isDimension
Listld

For a table, all column names should be unique following Oracle column naming standards.
All column names can contain only characters, numbers, and underscores. No special
characters are allowed.

Yes or No
Yes or No

All list attributes should be correctly mentioned, as per JavaClient.
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ListName = The name you want to appear with the data, as per JavaClient.
PageType = P2
DataType = Attribute Type Data Type Max. Length
Text VARCHAR2 255
List VARCHAR2 255
Multilist VARCHAR2 4000
Multitext VARCHAR2 4000
Money Money 38,6*
Numeric Number 38,6*
Date VARCHAR2 255
Length = The maximum number of characters expected from DataType.
ListTableName = Used to create a table for all list attributes. For two different list attributes with the same

Listld, only one table will be created.

* For Money and Numeric attribute types, the maximum length supports 38 characters, six
of which can be to the right of the decimal.

Sample Page 2 String for Affected Items
PC

You need to configure the PCExtnitmfields.xml file for Page 2. The configurable field parameters
appear in bold. This file must reside in the <AA_Home>/config/PCA

<?xml version="1.0" encoding="UTF-8"?>
<ExtnFields version="1.0" timestamp="Tue Jun 19 16:48:11 IST 2007" Enable="Y">
<CHNGITMFields
FetchCount="5000"
BatchCount="1000"
StagingTableName="CHANGES_AST_COM"
StagingAffltmTableName="CHNGITM_AST_COM"
StagingAffltmFlexTableName="REV_AST_COM_FLX"
StagingltmFlexTableName="ITEMS_AST_COM_FLX"
[tmTableColumnName="CHANGE"
DatamartFactTableName="CHNGITM_ADW_EXT_FCT"
DatamartDimensionTableName="CHNGITM_ADW_EXT_DIM">
</CHNGITMFields>
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</ExtnFields>

Pam

You need to configure the Extnltmfields.xml file for Page 2. This file must reside in the

<AA_Home>/config/Common folder.

<?xml version="1.0" encoding="UTF-8" ?>
<ExtnFields version="1.0" timestamp="2004-01-30T18:30:00 PDT" Enable="Y">

<PSRITMFields

FetchCount="5000"

BatchCount="1000"
StagingTableName="PRODUCT_SERVICE_REQUES_AST_PQM"
StagingAffltmTableName="PSRITM_AST_PQM"
StagingAffltmFlexTableName="PSRITM_AST_PQM_FLX"
StagingltmFlexTableName="ITEMS_AST_COM_FLX"
[tmTableColumnName="PSR_ID"
DatamartFactTableName="PSRITM_ADW_EXT_FCT"
DatamartDimensionTableName="PSRITM_ADW_EXT_DIM">

</PSRITMFields>
<QCRITMFields

FetchCount="5000"
BatchCount="1000"
StagingTableName="QUALITY_CHANGE_REQUEST_AST PQM"

StagingAffltmTableName="QCRITM_AST_PQM"
StagingAffltmFlexTableName="QCRITM_AST_PQM_FLX"
StagingltmFlexTableName="ITEMS_AST_COM_FLX"
[tmTableColumnName="QCR_ID"
DatamartFactTableName="QCRITM_ADW_EXT_FCT"
DatamartDimensionTableName="QCRITM_ADW_EXT_DIM">

</QCRITMFields>
</ExtnFields>

Where:
FetchCount
BatchCount
StagingTableName
StagingAffltmTableName
StagingAffltmFlexTableName

Minimum value: 1000, maximum value: 5000
Minimum value: 1000, maximum value: 2000
Staging tablename located in the staging database
Staging Affected Item table name

Staging Affected Item Flex table name
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FetchCount = Minimum value: 1000, maximum value: 5000
BatchCount = Minimum value: 1000, maximum value: 2000
StagingTableName = Staging tablename located in the staging database
StagingltmFlexTableName = Staging Item Flex table located in the staging database
[tmTableColumnName = Staging Affected Item Column name
DatamartFactTableName = Extension fact table tablename

Extension dimension table tablename

DatamartDimensionTableName

Sample Configuration for PSRItmFields

<ExtnField

ID="4878"

Attributeld="6636

DataMartColumnName="P2_4878Conforming_1"

isMeasure="YES"

isDimension="YES"

Listld=""

ListName=""
PageType="P2"
DataType="VARCHAR2"
Length="255"
ListTableName=""/>

<!-- Place the configured PSRItmFields strings in between PSRITMFields as shown in the following
example -->

<PSRITMFields
FetchCount="5000"
BatchCount="1000"
StagingTableName="PRODUCT_SERVICE_REQUES_AST_PQM"
StagingAffltmTableName="PSRITM_AST_PQM"
StagingAffltmFlexTableName="PSRITM_AST_PQM_FLX"

StagingltmFlexTableName="ITEMS_AST_COM_FLX"
ItmTableColumnName="PSR_ID"

DatamartFactTableName="PSRITM_ADW_EXT_FCT"
DatamartDimensionTableName="PSRITM_ADW_EXT_DIM">
<ExtnField

ID="4878"
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Attributeld="6636"
DataMartColumnName="P2_4878Conforming_1"
isMeasure="YES"

isDimension="YES"

Listld=""
ListName=""
PageType="P2
DataType="VARCHAR?2"
Length="255
ListTableName=""/>

</PSRITMFields>

<!-- Follow the previous steps to configure QCRItmFile strings and place the configured
QCRItmFile strings in between QCRItmFields as shown in the following example -->

<QCRFields
FetchCount="5000"
BatchCount="1000"
StagingAffltmTableName="QCRITM_AST_PQM"
StagingAffltmFlexTableName="QCRITM_AST_PQM_FLX"
StagingltmFlexTableName="ITEMS_AST_COM_FLX"
[tmTableColumnName="QCR_ID"
DatamartFactTableName="QCRITM_ADW_EXT_FCT"
DatamartDimensionTableName="QCRITM_ADW_EXT_DIM">
<ExtnField
ID="4428"
Attributeld="4140"
DataMartColumnName="P2_4428Date01_1"
isMeasure="YES"
isDimension="YES"
Listld=""
ListName=""
PageType="P2
DataType="VARCHAR2"
Length="255"
ListTableName=""/>
</QCRFields>

<!-- Place the configured Extnltmfields.xml in the <AA_Home>/config/Common folder before starting
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the AgileAnalytics Task chain. -->

Using DT/Studio to Run Agile PLM Datamart ETL Scripts

After you install Agile PLM Datamart ETL components, the <AA_HOME>\ETL folder contains XML
scripts used to extract, transform, and load data. In DT/Studio, these scripts are also referred to as
task definition files. They perform the following functions:

o Extract data from the Agile PLM database.

= Transform the records so they adhere to the structure in the Agile PLM Datamart database
schema.

@ Load the data into the Agile PLM Datamart database.

How Your Agile License Key Affects ETL Tasks

Your ability to run ETL tasks for individual Agile PLM Datamart modules is based on your Agile
license key. For example, if you have a license key only for the PQM Datamart, you cannot run
PPM Datamart and PC Datamart ETL tasks.

Starting an Agile PLM Datamart Task in DT/Studio

You can run Agile PLM Datamart ETL scripts using DT/Console, a Java application. The XML
scripts are DT/Studio task definition files.

To run an Agile PLM Datamart ETL script:
1. Make sure DT/Engine Manager is started.

2. Start DT/Console by clicking Start > Programs > Embarcadero DT/Studio 2.3.1 > Embarcadero
DT/Console 2.3.1 > DT/Console 2.3.1.

3. If this is the first time you are running DT/Console or if you do not automatically connect to the
DT/Engine, you are prompted to log in. Enter the username and password, and click OK.

Note The default DT/Engine username/password is dtadmin/dtadmin123. For
information about changing the DT/Engine password, see Changing the
DT/Engine Password.

4. After logging in, open the Tasks node. By default, the following tasks appear:

® PLM_AA POST TASK — Increments the batch number by one for Agile PLM Datamart data
loads.

® PLM_ADW _COM_ALL — Loads common Agile PLM data from the staging schema into the
dimensional schema of the Agile PLM Datamart.

® PLM_ADW_PA ALL — Loads data related to PPM from the staging schema into the
dimensional schema of the Agile PLM Datamart.

® PLM_ADW_PA EXT ALL — Loads data related to PPM baseline information from the staging
schema into the dimensional schema of the Agile PLM Datamart.

* PLM_ADW _PCA ALL - Loads data related to Product Collaboration from the staging schema
into the dimensional schema of the Agile PLM Datamart.
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® PLM_ADW_PQA_ALL — Loads data related to Product Quality Assurance from the staging
schema into the dimensional schema of the Agile PLM Datamart.

® PLM_AST_COM_ALL — Extracts common Agile PLM data from the Agile PLM database and
loads it into the staging schema of the Agile PLM Datamart.

® PLM_AST_PA_ALL — Extracts PPM data from the Agile PLM database and loads it into the
staging schema of the Agile PLM Datamart.

® PLM_AST PCA ALL — Extracts Product Collaboration data from the Agile PLM database and
loads it into the staging schema of the Agile PLM Datamart.

® PLM_AST PQA ALL - Extracts PQM data from the Agile PLM database and loads it into the
staging schema of the Agile PLM Datamart.

Note A task chain called Agile Analytics runs all the above tasks.If no tasks appear in
the Tasks node, it could be because the DT/Repository has not been set.
Forinformation on how to set the repository, see the separate DT/Studio
documentation..2]

5. Select the task chain (Agile Analytics) and click the Start button.

Note Before starting to extract Agile PLM data, make sure the Agile PLM application
server and the Agile PLM database are both up and running.

When you run a DT/Studio task such as PLM_AST_PA_ALL, it actually calls several subtasks to
move data from the Agile PLM database to the Agile PLM Datamart database. The subtasks extract
and load all Agile PLM data, not just the information that changed since the last time you ran the
task.

The time it takes to perform a data load depends on the size of data contained in your Agile PLM
system. It can take several hours.

Weekly or nightly batch runs are recommended, but multiple batches may be processed as
required. You can use the DT/Console scheduler to schedule a task to run automatically.

The results from each task that you run are stored in task log files, which are accessible from the
Log tab in DT/Console.

Recommended Order of Tasks

The Agile Analytics task chain runs Agile PLM Datamart tasks in the following order:
PLM_AST COM_ALL
PLM_AST_PA ALL
PLM_AST_PCA_ALL
PLM_AST_PQA_ALL
PLM_ADW_COM_ALL
PLM_ADW_PA_ALL
PLM_ADW_PCA ALL
PLM_ADW_PQA ALL
PLM_ADW_PA_EXT_ALL
10. PLM_AA_POST_TASK

© ©®© N o g M DN PR
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Of course, it's really only essential to run the tasks that load data into the staging schema first
(PLM_AST_COM_ALL, PLM_AST_PA_ALL, PLM_AST_PCA_ALL, and PLM_AST_PQA_ALL).
What you do with the staged data is completely up to you. Once the data is in the staging area, you
can perform other transformations before loading the data into the dimensional schema.

Stopping a DT/Studio Task

DT/Studio runs a task until it and its subtasks are finished. You can stop a task from running at any
time. If you want to stop a task from running mid-task, you must first close DT/Console and then
stop and restart DT/Engine.

To stop an Agile task running in DT/Studio:

Because Agile tasks run in a separate Java program, rather than stopping DT/Console as described
above, simply close DT/Console and then stop DT/Engine. When you are ready for your task to run
again start DT/Engine and then open DT/Console. Whether or not your task resumes running where
it left off or starts again from the beginning depends on the properties you set for the task. For more
information, see the next section.

Modifying a Task’s Properties

You can restart a task that you've stopped. How the task behaves when you restart it depends on
settings contained in the task’s custom.properties file. The custom.properties files are located in the
<AA_HOME>\ETL subfolders (Common, PA, PCA, PQA, Staging).

For example, if the isFullLoad property is set to 1 (True), the task runs from beginning to end. If
isFullLoad is set to O (False), then the task runs from the last subtask that completed successfully.

The following table lists the properties you can set for each task.

Property Description

debug Sets whether logging is enabled. Default is 1 (true).

isFullLoad Sets whether to perform a full load of data, or to resume from the last subtask that was completed.
Default is 1 (true).

initialize Sets whether to deploy the task to the repository. Default is 1 (true).

dbtype Sets the database type.

CUSTOM_TASK The specified custom task is used to move some statistical data to a table in the administrative
schema of the Agile PLM Datamart. Do not modify this setting.

PRE_TASK Sets global variables for DT/Engine before running the task.

POST_TASK Resets global variables for DT/Engine after running the task.

Checking the Task Log

After running a DT/Studio task, you can check Log tab to see if the data loaded successfully. If any
of the task chains fail, you need to identify which of the subtasks failed and then view the task’s file-
based log.
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To view the file-based log for a DT/Studio task:

Select the Tasks node in the navigation pane in the left.

In the right pane, click the End Date/Time column to sort by the end date.

Scroll down until you see a task that aborted. The status column will read “Aborted.”
Right-click the aborted task, and choose View File Based Log from the shortcut menu.

Select a transformer that's red, which means it failed.

2 T o

Click Refresh to view the log.

Note The physical log files for DT/Studio tasks are stored in the <DT_HOME>\logs\task folder.

Scheduling DT/Studio Tasks

DT/Console provides a simple scheduling tool that lets you run tasks on a recurring basis, such as
daily or weekly.

You should schedule extractions and loading of data during off-hours, such as at night when very
few users are accessing the Agile PLM and Agile Datamart databases.

Note Before using the DT/Console scheduler, confirm that the system date and time on your
computer are accurate.
To schedule DT/Studio tasks:
1. In DT/Console, select the task and click the %= Add Schedule button.
The Schedule Properties dialog box appears.

2. Specify the schedule name, start date, start time, and recurrence settings (such as whether the
task runs on a daily basis). Click OK.

3. When prompted that the schedule has been added, click OK.

Changing the Datamart Password

This task describes how to change the Datamart user password using the Datamart Password
Change Utility.

To change the PLM Datamart password:
1. From the command prompt, run Datamart_Password.bat found in AA_ HOME\ETL folder.
2. Atthe prompt, enter a new password for the AAD, AST, and ADW users.

If no password is entered for three consecutive times, the Datamart Password Change Utility
will exit without effecting any change to existing passwords.

Changing the DT/Engine Password

This task describes how to change the DT/Engine user password using the DT/Engine Password
Change Utility.
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To change the DT/Engine password:

1.
2.
3.

Log in to DT/Engine with default username (dtadmin) and password (dtadmin123).
Right-click on the user row and select Change Password from the menu.

In the Change Password dialog:

a. Type in the old password (dtadmin123).

b. Type in the new password (for example, dtadmin321).
c. Confirm by retyping the new password.

d. When you are finished, click OK.

Execute DTEngine_Password.bat with the new password.
First, change the directory to your Analytics “home”™\ETL directory, for example:
cd D:\Agile921\Analytics\ETL

At the prompt, type DTEngine_Password.bat and the new password. So, using our example
password:

D:\Agile921\Analytics\ETL>DTEngine_Password.bat dtadmin321

Note If no password is entered three consecutive times, the DT/Engine Password
Change Utility will exit without effecting any change to existing passwords.

Restart DT/Engine Manager Service.
Start DT/Engine 2.3.1.

Start DT/Console and log in to DT//Engine with username (dtadmin) and the new password (in
our example, dtadmin321).

You can now initiate a PLM Analytics task chain.

Changing the DT/Engine Repository Password

The DT/Engine stores data in normalized form in a metadata repository. The repository provides
security, version control, and rollback capability. It also allows you to generate reports.

Note

The password must first be changed in the database before you change it in DT/Console.
The DT/Engine may not be able to connect to the database if you do not synch up the
passwords in the database and DT/Console.

To change the DT/Engine repository password:

1.
2.

Open DT/Console.

Click on the node.

You are prompted for a username and password.
Type username and password

The default username is dtadmin.

The default password is dtadmin123.

Note The password may have been changed by another user.
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Click OK.
Choose Edit > Properties > DT/Engine Properties.

The DT/Engine Properties dialog box appears.

Note You should not change any other settings in this dialog box unless you have
knowledge of the outcome.

In the Password field, type a new password and click Set.
Click OK to close the dialog box.
Close and restart DT/Console for the change to take effect

Stop and restart DT/Engine.
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Embarcadero DT/Engine Installation

This chapter includes the following:

ADOUL DT/STUTIO 2.3.1 ..ottt 77
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INSEAIlING DT/ENGING 2.3. 1 ..ttt ettt 78

INStAlliNG DT/CONSOIE 2.3. 1.t
Applying the Cumulative Patch for DT/Engine 2.3.1, Build 2655_r5
Backing Up and Upgrading FileS ... e ss s ssesnaes

About DT/Studio 2.3.1

This appendix provides a summary of installation steps for DT/Studio 2.3.1, a suite of Java-based
ETL tools from Embarcadero Technologies. For complete installation instructions as well as
hardware and software requirements, please see the separate DT/Studio documentation from
Embarcadero Technologies.

DT/Studio includes the following components:

o DT/Engine — A data integration engine that can move and transform data between
heterogeneous databases and files. DT/Engine’s ETL tool extracts the data from the source
Agile PLM system, performs transformation needed on the source data, and loads the data into
the Agile PLM Datamart.

= DT/Console — The monitoring component of DT/Studio. DT/Console is an administrative interface
that lets you monitor the DT/Engine and remotely manage and schedule ETL tasks.

Agile requires that you install Embarcadero Systems DT/Studio on a Windows 2003 compulter.
DT/Engine can point to a metadata repository (such as an Oracle database) on a Windows
computer. You can install DT/Engine and DT/Console in any order.

If a previous version of either DT/Engine or DT/Console is installed already, uninstall it before
installing version 2.3.1.

DT/Engine Repository

DT/Engine stores data in normalized form in a metadata repository. The repository provides
security, version control, and rollback capability. It also allows you to generate reports.

Agile recommends using the same database server you are using for the Agile PLM Datamart for
the DT/Engine repository database. Either create a new database instance on the Agile PLM
Datamart computer, or add a new user to the Agile PLM Datamart instance called DTUSER (or
something similar).
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Note When creating the DT/Repository user, please make sure the user is assigned the
resource and connect privileges in the database.

When you install DT/Engine, you are prompted to specify the repository database. If you prefer, you
can install DT/ Engine without specifying a repository. However, you will need to specify and
configure the repository later using DT/Console.

Downloading DT/Studio 2.3.1 Software

You can download DT/Studio software, documentation, and patches from Agile’s public FTP server.
For more information, contact Agile Software Operations.

Installing DT/Engine 2.3.1

To install DT/Engine:

1. Start the dtengine-2_3_1-windows-setup.exe program.
The Welcome screen appears. Click Next.
The License screen appears.

2. Read the Embarcadero license agreement. If you want to continue the installation choose |
accept and click Next.

The Location screen appears.
Specify the directory in which to install the product or accept the default. Click Next.
4. Confirm the installation settings. Click Next.
The Shortcuts screen appears.
5. Choose whether to install shortcuts for DT/Engine on the desktop or the Start menu. Click Next.
The Repository Database screen appears.
6. Choose Yes to configure the repository database. Click Next.
The Configure Database Repository screen appears.

7. Select the database type (for example, OracleServer9i) from the drop-down list. Type the
hostname, service name, an existing username and password, and the port (1521). Click Next.

Note For the service name, use the instance name you created when you set up the
DT/Engine repository, as specified in “DT/Engine Repository”.The username
and password should also match those you created in the DT/Engine
repository.

8. If a DT/Engine database repository already exists on that database, you are prompted to set or
recreate the repository. Choose Recreate. You will then receive a confirmation message. Click
OK.

The Specify Password for DTADMIN screen appears.
9. Type the username (the default is dtadmin) and password (the default is dtadmin123). Click Next.
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10.

11.

12.
13.

Note For information about changing the DT/Engine password, see Changing the
DT/Engine Password.

The JVM Settings screen appears.
Set the JVM minimum and maximum heap values to 1024. Click Next.

Refer to About JVM Heap Size for additional information.

The Configure Properties screen appears.
Accept the default configuration properties. Click Next.
The Installation Complete screen appears.
Enable Start DTEngine Manager Service. Click Finish.

You should receive a message that the service started. Click OK.

Installing DT/Console 2.3.1

To install DT/Console:

1.
2.

Start the dtconsole-2_3 1-win32-setup.exe program.
The Welcome screen appears. Click Next.
The License screen appears.

Read the Embarcadero license agreement. If you want to continue the installation choose
| accept and click Next.

The Location screen appears.

Specify the directory in which to install the product or accept the default. Click Next.
Confirm the installation settings. Click Next.

The Shortcuts screen appears.

Choose whether to install shortcuts for DT/Console on the desktop or the Start menu. Click
Next.

The Installation Complete screen appears. Click Finish.

Applying the Cumulative Patch for DT/Engine 2.3.1, Build
2655_r5

You need to obtain the DT/Engine patch from Embarcadero Technologies. It is a compressed file
labeled password_patch_dt_2.3.1. Extract the files into an available location.

To apply the DT/Engine patch:

1.

Stop the DT/Engine and DTEngineManagerService.
a. Go to Control Panel > Administrative Tools > Services.
b. Highlight DTEngineMangerService, right-click, and select Stop.
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2. Make sure the DT_HOME environment variable is pointing to the directory where DT/Engine is
installed (for example, D:\Program Files\Embarcadero\DTStudio\DTEngine2.3.1).

a. Highlight My Computer, right-click, and select Properties.

b. Select the Advanced tab.

c. Click Environment Variables.

d. Inthe System Variable area, highlight DT_Home, and click Edit.

The Edit System Variable dialog box appears.

e. Confirm the path in the Variable Value field corresponds to the installed location of
DT/Engine. Click OK until you close all open dialog boxes.

3. Back up the dtpatchtool.jar file located in %DT_HOME%\lib. Copy the dtpatchtool.jar provided as
part of this patch to %DT_HOME%\lib.
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4.

5.

6.

Open a command prompt window and change to the bin directory and run the dtpatchtool.bat
file from the command prompt. This starts a patch tool shell, as shown in the following
example.

WWINDOWS' system32' cmd.exe

Microsoft Windows [Version 5.2.37901]
<G> Copyright 1985-28A3 Microsoft Corp.

(AN

Ciwrset dt_home=D:“Program Files:Embarcadero“DIStudio“DTEngine2.3.1
C:srod DisProgram FilessEmbarcaderosDTStudiosDTEngine2.3.1%bin
Cawrd:

D:“Program Files“Embarcadero~DIStudio™DTEngine2.3.1%bin>

D:“Program Files“Embarcadero“DIStudio“~DTEngine2.3.1%bin>dtpatchtool.bat
DTPatchTool version 1.8 <G> Embarcadero Technologies. Inc. 2882

Uzage:

<applyilistiinfoiversioniverifyipatchinfoliuninstalliexitihelp>
[options] [args...]

{zpecify help followed by a command name for command—specific help?
Example :thelp apply

Would show *apply’ command details

DTPatchTool*info

DTEngine version @ 2_.3.1 build #2655 created on - B2-81-2805 12:88 AH
Patch Histowy =

Mo patches applied.

DTPatchTool>apply d:~2655_r5_jar
Successfully applied the patch @ 2655_w»h

DIPatchTool>info
DTEngine wersion = 2.3.1 build #265% — 2655 _»5 created on @ B2-/01-2085 12:88 AM

Patch History =
Patch #2655 _»5 waz applied on - B3-22-2007 10:54 AM (Revewrsible?

DTPatchTool*exit
D:“Program Files“Embarcadero~DIStudio“DTEngine2.3.1%bin>

Type the following commands to retrieve information about the current DT/Engine version.
DTPatchTool> info

If your current version is earlier than build 2655, apply the patch using the following syntax:
DTPatchTool> apply <patch_file_path>

For example, if the patch is located in d:\patch, enter the following command:
DTPatchTool> apply d:\patch\2655_r5.jar
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Note Do not start the DT/Engine and DTEngineManager service at this time.

Backing Up and Upgrading Files

After you apply the patch to DT/Engine for build 2655, you now must backup several files and
folders before upgrading them.

Upgrading consolecomm.jar for DT/Console 2.3.1

You must copy the consolecommijar file from DT/Engine to DT/Console.

To upgrade consolecomm.jar for DT/Console:

1. Stop DT/Console.
a. Go to Control Panel > Administrative Tools > Services.
b. Highlight DTConsoleMangerService, right-click, and select Stop.

2. Back up the consolecommjar file.

a. Locate the consolecomm.jar file at the DT/Console installation location.
(The default location is root:\Program Files\Embarcadero\ DTStudio\DTConsole2.3.1\lib)

b. Copy the consolecomm.jar file and rename the copy consolecomm.jar.bk.

3. After installing the DT/Engine patch for build 2655, copy %DT_HOME%\lib\consolecomm jar to
%DT_CONSOLE_INSTALL_DIR%!\lib.

4. Restart DT/Console.

a. Go to Control Panel > Administrative Tools > Services.
b. Highlight DTConsoleMangerService, right-click, and select Start.

Upgrading the DT/Engine 2.3.1 JVM

You must also upgrade the DT/Engine JVM.
To upgrade the DT/Engine JVM:

1. Stop the DT/Engine. If you are running the engine manager service, shut it down.

2. Create a new jdk1.4 folder.

a. Locate the jdk1.4 folder.
(The default location is root:\Program Files\Embarcadero\ DTStudio\DTConsole2.3.1\)

b. Rename the jdk1.4 folder to jdk1.4_old.
c. Create a new folder and name it jdk1.4.

3. Copy the dtengine-2_3_1-win32-installer.exe file.

a. Locate the dtengine-2_3_1-win32-installer.exe file.
(The default location is root:\.. \DTEnginelnstalls\DT 2.3.1)

b. Copy the dtengine-2_3_1-win32-installer.exe file.
c. Paste the copy into the jdk1.4 folder.
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(The default location is root:\Program Files\Embarcadero\ DTStudio\DTConsole2.3.1\)

4. From the jdk1.4 folder, double-click the dtengine-2_3_1-win32-installer.exe file. This self-extracting
installer extracts the new JDK files into the jdk1.4 folder.

5. Re-start the engine or engine manager service.

Managing DT/Engine 2.3.1 JVM Heap Size

After you install DT/Engine, you can modify the JVM heap values to tune performance.

To modify DT/Engine JVM heap values:

1. Stop the DT/Engine. If you are running the engine manager service, shut it down.
2. Got to DT/Engine bin folder - %DT_HOME%/bin.

3. Open dtengine.jain a text editor.
4

Confirm the values for the two java heaps are 1024 and the java stack is 256, as shown in the
following example:

%IF_EXISTS%("INIT_JAVA_HEAP", "@INIT_JAVA_HEAP@1024m")
%IF_EXISTS%("MAX_JAVA_HEAP", "@MAX_JAVA_HEAP@1024m")
%IF_EXISTS%("INIT_JAVA_STACK", "@INIT_JAVA_STACK@256k")

5. Start the DT/Engine and DTEngineManagerService.
a. Go to Control Panel > Administrative Tools > Services.
b. Highlight DTEngineMangerService, right-click, and select Start.

About JVM Heap Size

The JVM heap is a repository for live objects, dead objects, and free memory. When a JVM runs out
of memory in the heap, all execution in the JVM stops. A garbage collection algorithm then goes
through memory and frees space that is no longer required by the application.

JVM Heap Size determines when the VM starts collecting DT/Engine garbage (deallocating unused
Java objects). The smaller the heap, the more often garbage is collected. To minimize the time
spent on garbage collection and maximize server efficiency:

o Make sure that the heap size is not larger than the available free RAM on your system.
Typically, you should use 80% of the free RAM available for your JVM.

= Lower the heap size if you find that your system is spending too much time collecting garbage.

@ Set the Minimum Heap Size equal to the Maximum Heap Size. Setting the minimum heap size
equal to the maximum heap size yields a higher performance throughput than setting the
values differently. Setting equal values also prevents the JVM from spending time incrementing
the heap.
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Oracle Installation

This chapter includes the following:

Installing Oracle 10g 0N WINAOWS .......cccvviieiiiiriesisissse e sssiss e ssssss s s s s ssss st sensssessssenes 85
Installing Oracle 10g Release 2 0N WINAOWS ........cv.vevveiiriieiieesirssesssssssssseess s sssssssssssssssssesesssnens 88
Installing Oracle 9i ON WINAOWS.........ciriieirrirririereessesiseseeesees s esssesss s sess s ssssessssssssessssessssssesesssseens

Installing Oracle 9i Release 2 on Windows
INSLAllING OrACIE ON SOIAIS ........vvceiietiire ettt bbb

Installing Oracle 10g on Windows

Before installing Oracle, you must:

o Check to see that the Microsoft NTFS file system is used instead of FAT or FAT32, and convert
the file system if necessary. See Checking the Windows File System for directions.

= Determine the name of the Windows computer where Oracle is to be installed.

Note It is required that the computer on which you are installing the Oracle database
have at least two physical disks or two logical partitions. This allows you to
place the operating system on the C drive and use the D drive for Oracle
components. The examples in this chapter use a C and D drive.

= Be sure that you have Administrator privileges within Windows on the computers where you are
installing Oracle and Agile PLM Datamart.

@ Disable disk compression, if you are using it.

o Disable virus protection, if you are using it. Components used in the installer can be falsely
identified as being infected and lock up the installation. You can turn the virus protection on
after the installation is complete.

Network Check

Before proceeding, it is important to confirm two settings to prevent difficulties from occurring.
Confirming Computer Name and Hostname |dentities

The computer where Oracle is installed must use the same value as both its computer name and its
DNS hostname. The following procedures can be used to identify the current values.

To determine the computer name for Windows:
1. Right-click the My Computer icon on the desktop, and choose Properties in the shortcut menu.

2. Inthe System Properties dialog box, click the Computer Name tab.
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3. Note the name listed in the Full Computer Name field.
Confirming the Server Date

It is important to adjust the date and time of the computer. The date and time need to be correct
when you work with your production data.

To confirm the date and time, click the Date/Time icon in the Windows Control Panel. Be sure to
verify the Time Zone setting as well.

Note If you change the date or time after Agile PLM Datamart has been installed and started,
you need to stop and restart Oracle immediately after the change.

Checking the Windows File System

Agile recommends that servers use NTFS (NT File System) rather than FAT or FAT32 (File
Allocation Table), as NTFS is more robust.

To determine the file system type:

1. Check the file system used on the computer. Choose Start > Settings > Control Panel >
Administrative Tools > Computer Management. Under Computer Management in the left pane,
expand Storage and select Disk Management.

The Disk Administration windows opens.

There must be at least two partitions or hard drives. If your computer uses NTFS, proceed with
the Oracle installation. If your computer uses a FAT or FAT32 file system, Agile recommends
converting it to NTFS before proceeding.

Important Converting the file system deletes all current files on the drive. Backup all necessary files
before converting the file system to NTFS.

To convert the file system to NTFS:

2. Right-click on the drive you want to reformat and choose Format in the shortcut menu.
3. Inthe File System field, change the file system type to NTFS.

4. Click Start.

The process takes several minutes. On completion, restart the system. You can proceed with the
Oracle installation.

For Servers Configured with DHCP

If your server is configured with DHCP (Dynamic Host Configuration Protocol), there is a known
issue with the Oracle 10g installation. The installation fails and the following message appears:

Thrown When the IP address of a host cannot be determined
There are two possible solutions:

= Copy the Oracle 10g installation software to your local disk and perform an off-network
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o

installation.

Install the Microsoft Loopback adapter on the DHCP server, then add one entry to the hosts
file.

To install the Microsoft Loopback adapter:

© ©® N o g M DN PE

Click Start > Control Panel > Add/Remove Hardware. The Add/Remove Hardware wizard appears.
Click Next.

Choose Yes, | have already connected the hardware, then click Next.

Choose Add a new hardware device, then click Next.

Choose Install the hardware that | manually select from a list, then click Next.

Select Network adapters, then click Next.

In the Manufacturers list, select Microsoft.

In the Network Adapter list, select Microsoft Loopback Adapter, then click Next.

Click Next to install the adapter.

10. Click Finish.

To configure the hosts file:

1.
2.

Open the hosts file, located at C:\Windows\System32\drivers\etc.
Add the following entry to the hosts file:
10.10.10.10 hostname.domain hostname

For example, if the full machine name of your database server is dbl.agile.agilesoft.com, the
entry in the hosts file would be:

10.10.10.10 dbl.agile.agilesoft.com dbl

Save the file.

To configure the loopback IP address on the network:

1.
2.
3.

On the database server, right-click the My Network Places icon.
Choose Properties to display the Network and Dial-up Connections window.

Locate a connection with the device name of Microsoft Loopback Adapter. This connection is
usually Local Area Connection 2.

Right-click this connection icon.
Choose Properties to display the Local Area Connection 2 Properties dialog box.

On the General tab, select Internet Protocol (TCP/IP), then click Properties to display the Internet
Protocol (TCP/IP) properties dialog box.

On the General tab, choose Use the following IP Address.
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8. Enter the following values:
IP address: 10.10.10.10
Subnet mask: 255.255.255.0

9. Click OK.

10. Click Close.

11. On completion, restart the system. You can proceed with the Oracle installation.

Installing Oracle 10g Release 2 on Windows

These instructions describe how to install and configure Oracle 10g to run with Agile PLM Datamart.
There are two Oracle installation CDs - one for the Oracle database and one for Oracle companion
components.

Note Throughout the instructions, default values are shown (such as the installation path or the
service name). If you change any of these values during the installation, update the
information specific to your installation where appropriate.

Important Make sure the Distributed Transaction Coordinator service is stopped.

To install Oracle 10g:

12. Insert the Oracle database installation CD. You may have to navigate to the CD drive.

13. Double-click the Setup icon.

14. The Oracle Universal Installer command window and welcome screen appear. Click Next.
The Installation Method window appears.

15. Select Basic Installation. Make sure the Oracle Home Location is on the D drive at
d:\oracle\product\10.2.0\db_1 which is the default if you have two disks.

16. Select Enterprise Edition as the Installation Type. Click Next.

Note Do not check Create Starter Database. You will create the Agile database with the
Database Configuration Utility. The Product Specific Prerequisite Checks
window appears.

17. The Oracle Universal Installer verifies that your server meets the minimum requirements for
installing and configuring the options you have selected. If your system passes, a summary
window appears. Click Next.

18. Click Install.

19. Click Exit when the installation is complete.

20. Remove the Oracle database CD from the CD drive.

21. Insert the Oracle companion CD. You may have to navigate to the CD drive.

22. Double-click the Setup icon. The Oracle Universal Installer command window and welcome screen
appear. Click Next.

The Select A Product To Install window appears.

Page - 88 Datamart Setup Guide



Chapter 8

23.

24,

25.

26.
27.

Select Oracle Database 10g Products 10.2.0.1.0. Click Next.

The Specify Home Details window appears.

Select the Oracle Home where you installed the Oracle 10g database. Click Next.
The Product Specific Prerequisite Checks window appears.

The Oracle Universal Installer verifies that your server meets the minimum requirements for
installing and configuring the options you have selected. If your system passes, a summary
window appears. Click Next.

Click Install.

Click Exit when the installation is complete. This completes the Oracle installation.

Installing Oracle Patch 4547817

After you create the database instance for the Agile PLM Datamart (see Installing the Datamart
Database Server), try starting the OracleServiceAADM service. If the service starts but the database

remains idle, you should install Oracle patch 4547817.

To install Oracle patch 4547817:

2 T o o

10.

Download Oracle patch 4547817 from Oracle Metalink https://metalink.oracle.com
Stop all Oracle services on the database server.
Run setup.exe from Disk1 folder for the patch. This program upgrades Oracle to 10.2.0.2.
Start the Oracle database service OracleServiceAADM
Open a Command Prompt window.
Start SQL*Plus and log in as the SYS user:
sqlplus sys/oracle as sysdba
It should say "connected to an idle instance".
Start the database in upgrade mode
SQL> startup upgrade;
Run the catupgrd.sql script, which is located in $ORACLE_HOME/rdbms/admin.
SQL> @d:\oracle\product\10.2.0\db_1\RDBMS\ADMIN\catupgrd.sq|l

Run the Registry Editor (regedit). Make sure the ORA_<SID>_AUTOSTART value in the
registry key HKEY LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_OraDb10g_homel is set
to TRUE.

Restart the server.

Oracle should now start the database when the service is started.

Installing Oracle 9i On Windows

Important Agile PLM Analytics requires Oraclel10g. If you are installing both Agile PLM Datamart and

Agile PLM Analytics, Oracle9i is not supported.

Before installing Oracle, you must:
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@ Check to see that the Microsoft NTFS file system is used instead of FAT or FAT32, and convert
the file system if necessary. See Checking the Windows File System or directions.

o Determine the name of the Windows computer where Oracle is to be installed. The target
installation folder for the Oracle database is recommended to be d:\oracle\ora92.

Note It is required that the computer on which you are installing the Oracle database
have at least two physical drives or two partitions. This allows you to place the
operating system on the C drive and use the D drive for Oracle components.
The examples in this chapter use a C and D drive.

= Be sure that you have Administrator privileges within Windows on the computers where you are
installing Oracle and Agile PLM Datamart.

@ Disable disk compression, if you are using it.

@ Disable virus protection, if you are using it. Components used in the installer can be falsely
identified as being infected and lock up the installation. You can turn the virus protection on
after the installation is complete.

The following sections provide more information about these procedures.

Network Check

Before proceeding, it is important to confirm two settings to prevent difficulties from occurring.
Confirming Computer Name and Hostname Identities

The computer where Oracle is installed must use the same value as both its computer name and its
DNS hostname. The following procedures can be used to identify the current values.

To determine the computer name for Windows:
1. Right-click the My Computer icon on the desktop, and choose Properties in the shortcut menu.
2. Inthe System Properties dialog box, click the Computer Name tab.

3. Note the name listed in the Full Computer Name field.
Confirming the Server Date

It is important to adjust the date and time of the computer. The date and time need to be correct
when you work with your production data.

To confirm the date and time, click the Date/Time icon in the Windows Control Panel. Be sure to
verify the Time Zone setting as well.

Note If you change the date or time after Agile PLM Datamart has been installed and started,
you need to stop and restart Oracle immediately after the change.

Checking the Windows File System

Agile recommends that servers use NTFS (NT File System) rather than FAT or FAT32 (File
Allocation Table), as NTFS is more robust.

Page - 90 Datamart Setup Guide



Chapter 8

To determine the file system type:

1.

2.
3.
4.

The

Check the file system used on the computer. Choose Start > Settings > Control Panel >
Administrative Tools > Computer Management. Under Computer Management in the left pane,
expand Storage and select Disk Management.

The Disk Administration windows opens.

There must be at least two partitions or hard drives. If your computer uses NTFS, proceed with
the Oracle installation. If your computer uses a FAT or FAT32 file system, Agile recommends
converting it to NTFS beforeproceeding.

Note Converting the file system deletes all current files on the drive. Backup all
necessary files before converting the file system to NTFS.

Right-click on the drive you want to reformat and choose Format in the shortcut menu.
In the File System field, change the file system type to NTFS.
Click Start.

process takes several minutes. On completion, restart the system. You can proceed with the

Oracle installation.

Installing Oracle 9i Release 2 on Windows

These instructions describe how to install and configure Oracle 9i to run with Agile PLM Datamart.

Note

Throughout the instructions, default values are shown (such as the installation path or the
service name). If you change any of these values during the installation, update the
information specific to your installation where appropriate.

Important Make sure the Distributed Transaction Coordinator service is stopped.

To install Oracle 9i:

5.

Insert the Oracle database installation CD. You may have to navigate to the CD drive. Click
Next.

The Oracle Universal Installer welcome screen appears. Click Next.
The File Locations window appears.

Make sure the Oracle home folder is on the D drive at d:\oracle\ora92. Next.

Note If you are installing Oracle on a different drive, specify that drive instead.
The Available Products window appears.

Select Oracle9i Database 9.2.0.1.0. Click Next.

The Installation Types window appears.

Select Enterprise Edition. Click Next.
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Note If you have more than 4 CPUs, you must use Oracle 9i R2 Enterprise Edition.
The Standard Edition license only allows you to install on a server having up to
4 CPUs.

The Database Configuration window appears.

10. Select Software Only. Click Next.
The Oracle Services for Microsoft Transaction Server window appears.

11. Accept the default 2030 port number. Click Next.

12. Review the information to ensure that you have enough disk space. Click Install.
The Install window appears and displays a progress meter.

13. Insert the remaining CDs when prompted and browse to the \stage folder to continue the
installation.

14. Click Exit when the installation is complete.
The Add Databases to tree dialog appears.
15. Click Cancel.

16. Choose File > Exit from the Oracle Enterprise Manager Console window.

Editing the sqinet.ora File

For databases installed on Windows Server computers, you must check the sqlnet.ora file to make
sure authentication services are configured correctly.

To edit the sqlnet.ora file:
1. Go to the d:\oracle\ora92\network\admin folder.
2. In atext editor, open the sqglnet.ora file and look for the following parameter:

SQLNET.AUTHENTICATION_SERVICES
If the parameter is set to (None), you do not need to edit the file.

3. If the parameter is set to (NTS), place a pound symbol (#) at the beginning of the line so it
appears as follows:

# SQLNET.AUTHENTICATION_SERVICES= (NTS)

Note If you do not want to comment out the line, you can change (NTS)to (NONE).

4. Save and close the file. This completes the Oracle installation.

Installing Oracle on Solaris
Important An Oracle database administrator should install this product.

Installation Sequence

This chapter provides information for installing an Agile PLM Datamart database on Sun Solaris.
Before you begin, make sure that you have reviewed all relevant Oracle documentation and
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ensured the computer meets the minimum system requirements.

Important For best results, start with a clean system (no previous versions of Oracle).

The installation process consists of four major steps:

5. Prepare an installation environment.

6. Install Oracle 9i Release 2 or Oracle 10g Release 2.

7. Run the Agile PLM Datamart database scripts to create the Agile PLM Datamart database.
8

Configure Oracle network connectivity and set additional Oracle functionality.
Oracle Source Documentation

Before you begin, it is important to be familiar with all the information about installing the Oracle
database on Solaris, and with the Optimal Flexible Architecture (OFA) reference material for
administrators. See the following Oracle documents:

@ QOracle 9i Installation Guide Release 2 (9.2.0.1.0) for UNIX Systems: AlX-Based Systems,
Compagq Tru64 UNIX, HP 9000 Series HP-UX, Linux Intel, and Sun Solaris.

= QOracle 9i Administrator's Reference Release 2 (9.2.0.1.0) for UNIX Systems: AlX-Based
Systems, Compag Tru64 UNIX, HP 9000 Series HP-UX, Linux Intel, and Sun Solaris in
Appendix G: “Optimal Flexible Architecture.”

These documents are available on the Oracle Technology Network at:
http://otn.oracle.com/documentation/oracle9i.html
http://otn.oracle.com/documentation/oracle9i.html

= Oracle 10g Installation Guide Release 1 (10.1) for UNIX Systems: AlX-Based Systems, hp HP-
UX PA-RISC (64-bit), hp Tru64 UNIX, Linux x86, and Solaris Operating System (SPARC)

@ Oracle Database Administrator’'s Guide 10g Release 2 (10.2)

These documents are available on the Oracle Technology Network at:
http://www.oracle.com/technology/documentation/database10gR2.html
(http://www.oracle.com/technology/documentation/index.html)

Note Agile has made every attempt to be OFA-compliant. Any deviation from OFA
guidelines are noted.

System Requirements

Before installing Oracle, ensure that your system configuration meets the minimum hardware
requirements. If you are using a stand-alone system or hosting multiple instances, consider using
the recommended hardware requirements for the specific environment to ensure acceptable
performance. For information on specific system requirements, see the Agile PLM Capacity
Planning and Deployment Guide.

It is suggested that a Solaris system administrator and Oracle database administrator are available
to monitor system activity and determine resource requirements.

Preparing the Host Computer

This section describes how to prepare the installation environment on Solaris, such as creating the
necessary groups and user accounts.

Page - 93


http://otn.oracle.com/documentation/oracle9i.html
http://www.oracle.com/technology/documentation/index.html

Agile PLM Analytics 2.1.1

Note Oracle 9i Release 2 uses three CDs. To avoid changing CDs during the installation, you
should create an area containing the Oracle installation files.
To create the Oracle user account:
1. Login to the system as root.
2. Create a home directory for the Oracle user:
# mkdir -p /u0l/oracle [Enter]
3. Create two groups called oinstall and dba:
# groupadd oinstall [Enter]
# groupadd dba [Enter]
4. Create the Oracle user:
# useradd -d /u01/oracle -s /bin/sh -g
oinstall -G dba oracle [Enter]
where:
fu0l/oracle is the Oracle user home directory
[bin/sh is the Oracle user login shell
oinstall is the primary group for the Oracle
userdba is the secondary group for the Oracle user
5. Set the Oracle user password, and change the Oracle home file ownership:
# passwd oracle [Enter]
Enter password:
# chown oracle:dba /uOl/oracle [Enter]
6. Create the Oracle installation directory:
# mkdir -p /u0l/app/oracle [Enter]

# chown oracle:oinstall /u01/app/oracle [Enter]

You must now copy the Agile PLM Datamart database scripts.

To copy the Agile PLM Datamart database utilities:

1. Change to the Oracle user, and create a temporary directory named “aadmtmp:”
# su - oracle [Enter]
$ mkdir /u0l/oracle/aadmtmp [Enter]

2. If you obtained the Portfolio Analytics installation bundle from the Agile FTP site, uncompress it
at the root of your drive.

If you obtained a Portfolio Analytics CD, insert the CD and copy the aadmdb.tar.Z file from the
CD to the aadmtmp directory:
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$ cd /cdrom [Enter]
$ cd /CD1_Agile/DB/Oracle9i or 10g
$ cp aadmdb.tar.Z /u0l/oracle/aadmtmp [Enter]

Note If you are installing and upgrading the database from the Agile installation CDs
for Windows, but have a Solaris database, the database scripts can be found in
the CD1_Agile\Windows\DB\Solaris directory.

3. Change to the aadmtmp directory, and uncompress the files from the aadmdb.tar.Z file:
$ cd /u0l/oracle/faadmtmp [Enter]
$ uncompress aadmdb.tar.Z [Enter]
4. Extract the aadmdb.tar file:
$ tar -xvf aadmdb.tar [Enter]
The aadmdb.tar.Z file contains the following files:
* aadm.sh — Bourne shell script for creating the database and schema
*  profile.txt — oracle user .profile template
*  system.txt — system kernel parameters
* dbora— setup for the database automatic shutdown and startup

To modify the system kernel parameters:

1. Change to the root user, and back up the /etc/system file:
$ su - [Enter]
# cp letc/system letc/system_save [Enter]

2. Verify the following /etc/system kernel parameters. If the parameters do not exist, go to the next

step.

set shmsys:shminfo_shmmax 4294967295
set shmsys:shminfo_shmmin 1

set shmsys:shminfo_shmmni 100

set shmsys:shminfo_shmseg 32

set semsys:seminfo_semmns 1000

set semsys:seminfo_semmni 100

set semsys:seminfo_semmsl| 500

set semsys:seminfo_semopm 100

set semsys:seminfo_semvmx 32767

Important If you have been running the host computer as an Oracle database server, you have to
check with your Solaris system administrator before changing these parameters. For
these parameter settings, you can also refer to the Oracle 9i or Oracle 10g installation
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documentation.

Note Restart the computer if you modify the /etc/system file.

The previous kernel parameters are set in the distributed system.txt file. Append system.txt to
/etc/system if this is the first time you are configuring the host computer as the database server.

# cat /Ju0l/oracle/faadmtmp/system.txt >> fetc/system

Note Use >> to append. If you have accidentally used >, you need to recover the
original /etc/system file by using cp system_save system.

Restart the system to make the new kernel configuration take effect.

Note If you do not restart the system, the database creation will fail. You may need
to check with your Solaris system administrator for support.

To set up Oracle environmental variables:

1.
2.

Log in to the system as the Oracle user.

Create the environmental parameter file .profile to include:

PATH=SPATH: /usr/local/bin: /usr/ccs/bin: /usr/openwin/bin: /usr/bin/X11

export PATH

ORACLE_HOME=/u0l/app/oracle/product/9.2.0SE; export ORACLE HOME

ORACLE BASE=/u0l/app/oracle; export ORACLE BASE

PATH=$PATH: $ORACLE_HOME/bin; export PATH

ORACLE_SID=aadm; export ORACLE SID

TNS_ADMIN=/var/opt/oracle; export TNS ADMIN

NLS_LANG=American America.UTF8; export NLS_LANG

Note If you are using Oracle 10g, substitute /uOl/app/oracle/product/109.2.0SE for
the Oracle home.

The environmental parameters in the previous step are set in the distributed profile.txt file. If
this is the first time you are configuring the host computer as a database server, copy the
profile.txt file to .profile:

$ cat aadmtmplprofile.txt > .profile [Enter]
Update the environmental setting:
$ . ./.profile [Enter]

Making the Oracle Installer Available

To simplify the Oracle installation, you can copy the data from the Oracle installation CDs onto the
Solaris computer. Use the instructions in “Installing Oracle 9i” in the Agile PLM Database
Installation Guide for Oracle to copy the data from the installation CDs.
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Creating the Agile PLM Datamart Database

This section describes how to create the Agile PLM Datamart database instance and schemas.

To create the Agile PLM Datamart database:

1. Log in to the computer as the Oracle user.
a. If necessary, edit the .profile file to change Oracle SID. By default, Agile CM uses aadm as
the Oracle SID:
$ vi .profile [Enter]

b. Modify the value, where ORACLE_SID=aadm by replacing aadm with the SID you want to
use.

Important Check the /var/opt/oracle/oratab file and make sure that the specified Oracle SID has not
been used. Specifying an existing Oracle SID can corrupt that database instance.

Note Generally, the SID length is four alphanumeric characters. This avoids lengthy
database filenames for associated database files.

c. Run .profile to make the SID changes take effect:
$. Lprofile [Enter]
In a second terminal session, log in to the computer as the root user.

3. Create a directory named “oradata.”

Note The aadm.sh file uses a dummy mount point /mpt. You must change /mpt to
match your mount points. For OFA compliance, it is highly recommended that
you create at least four mount points (preferably on four different disks across
multiple controllers) to optimize disk I/O.

For example, if you have mount points at /u01 and /u02, you can create an oradata folder on
each mount point.

# mkdir -p /u0l/oradata
# chown oracle:dba /u01/oradata

4. In the session where you are logged in as the Oracle user, create a $ORACLE_BASE/admin
directory:

$ mkdir -p /u01/app/oracle/admin [Enter]
You must now run the aadm.sh script.
5. Change to the /uOl/oracle/aadmtmp directory.

Modify the aadm.sh script to match the mount points on your computer, and then copy the
script to the Oracle user home directory (/luOl/oracle).

Important Make sure ORACLE_SID matches the one you set for .profile, which should have taken
effect after you ran . ./.profile.

Note The aadm.sh file uses a dummy mount point /mpt. You must change /mpt to
match your mount points. For OFA compliance, it is highly recommended that
you create at least four mount points (preferably on four different disks across
multiple controllers) to optimize disk 1/O.

The values in the script that can be modified appear in bold. You should limit your editing only
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to these bold values.

For example, if you have a mount point created at /u01, you can modify aadm.sh and quickly
recreate it in the Oracle user home directory by issuing one command.

$ cat /u0l/oracle/aadmtmp/aadm.sh | sed -e "s/imptV/u01V/g" > /u0l/oracle/aadm.sh

$ chmod u+x /u0l/oraclefaadm.sh

Note The following code lists variables in bold that you may want to revise besides
dummy mount point /mpt

##!/bin/sh

#

# =========================================================

# Copyright (c) 1995-2005 Agile Software Corporation

# All Rights Reserved.

#

# This is unpublished proprietary source code of Agile

# Software Corporation. The copyright notice above does not evidence

# any actual or intended publication of such source code.

# ==============================—=—=======—==—=================

#

# Oracle sid default as aadm

#

ORACLE_SID=aadm# Oracle SID for the database
AASYSPW=oracle# Oracle sys passwd for the database
AASYSTEMPW=manager# Oracle system passwd for the database
AST=ast# Oracle account for AST schema

ASTPW=ast# Oracle passwd for AST

AAD=aad# Oracle account for AAD schema

AADPW=aad# Oracle passwd for AAD

ADW=adw# Oracle account for ADW

ADWPW=adw# Oracle password for ADW

#

# Parameters determine location of datafiles, controlfiles and
logfiles

#

DATABASE SYSTEM=/mpt/oradata/${ORACLE SID}# SYSTEM tablespace mount
point

DATABASE TOOLS=/mpt/oradata/${ORACLE SID} # TOOLS tablespace mount
point

DATABASE UNDO=/mpt/oradata/${ORACLE SID} # RBS tablespace mount point
DATABASE TEMP=/mpt/oradata/${ORACLE SID} # TEMP tablespace mount point
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DATABASE USERS=/mpt/oradata/${ORACLE SID} # USERS tablespace mount
point

DATABASE INDX=/mpt/oradata/${ORACLE SID} # INDX tablespace mount point

DATABASE AGILE DATAl=/mpt/oradata/${ORACLE SID}# AGILE DATA1l
tablespace mount point

DATABASE AGILE_ INDX1l=/mpt/oradata/${ORACLE_SID}# AGILE_INDX1
tablespace mount point

DATABASE AGILE DATA2=/mpt/oradata/${ORACLE SID}# AGILE DATA2
tablespace mount point

DATABASE AGILE INDX2=/mpt/oradata/${ORACLE SID}# AGILE_ INDX2
tablespace mount point

DATABASE AGILE DATA3=/mpt/oradata/${ORACLE SID}# AGILE DATA3
tablespace mount point

DATABASE_AGILE_INDX3=/mpt/oradata/${ORACLE_SID}# AGILE_INDX3
tablespace mount point

DATABASE AGILE DATA4=/mpt/oradata/${ORACLE SID}# AGILE DATA4
tablespace mount point

DATABASE AGILE INDX4=/mpt/oradata/${ORACLE SID} # AGILE INDX4
tablespace mount point

DATABASE LOGFILESl=/mpt/oradata/${ORACLE SID} # REDOLOG file 1 mount
point

DATABASE LOGFILES2=/mpt/oradata/${ORACLE SID} # REDOLOG file 2 mount
point

DATABASE_LOGFILESB=/mpt/oradata/${ORACLE_SID} # REDOLOG file 3 mount
point

DATABASE LOGFILES4=/mpt/oradata/${ORACLE SID} # REDOLOG file 4 mount
point

DATABASE CONTROL1=/mpt/oradata/${ORACLE SID} # CONTROL file 1 mount
point

DATABASE CONTROL2=/mpt/oradata/${ORACLE_SID} # CONTROL file 2 mount
point

DATABASE_CONTROL3=/mpt/oradata/${ORACLE_SID} # CONTROL file 3 mount
point

DATABASE ARCHIVE=/mpt/oradata/${ORACLE SID}/arch # ARCHIVELOGS mount
point

#

# Parameters determine character set used

#

CHARACTER SET=UTF8

NATIONAL CHARACTER SET=UTF8

Run the aadm.sh script from the Oracle user home directory:
$ cd [Enter]
$ Jaadm.sh [Enter]

Note If you are unable to create files, you may have to give the system user full
privileges to the u01 directory.
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8. You are prompted about the database size that you want to install.

You should use the regular database size unless you have consulted with an Agile Solutions
Consultant or database administrator to ensure that the computer meets the minimum
requirements for the specified database size.

The script will run for awhile.

Continue to the next section for post-installation tasks.

Post-Installation Tasks

This section describes how to configure Oracle Net Manager, and set the automatic startup and
shutdown features for the database.

Setting Up Oracle Net Manager

To set up Oracle Net Manager:

1. Login as root and change the ownership of the /var/opt/oracle directory:
# chown -R oracle:dba /var/opt/oracle [Enter]

2. Switch to the Oracle user, and change to the Oracle network directory:
# su - oracle [Enter]
$ cd /u0l/apploracle/product/9.2.0SE/network/admin [Enter]

3. 3 Move all the files to the directory defined by environmental parameter TNS_ADMIN, which is
/var/opt/oracle:

$ mv * var/opt/oracle [Enter]
Setting Up Automatic Shutdown and Startup for the Database
To set up the Oracle database to automatically shut down and start up when the host computer starts up and
shuts down:
1. Log in the system as root.
2. Create a file named “dbora” in the /etc/init.d directory:
# cat /u0l/oracle/aadmtmp/dbora > /etc/init.d/dbora[Enter]
3. Link to the dbora file:

# In -s /etc/init.d/dbora /etc/rc0.d/K10dbora [Enter]
# In -s /etc/init.d/dbora /etc/rc2.d/S99dbora [Enter] Configuring the listener.ora File

To configure the listener.ora file:
1. Start Net Manager:
$ netmgr &
2. Within the Local folder, open the Listeners folder and select LISTENER.

Page - 100 Datamart Setup Guide



Chapter 8

Check to see if the following settings appear in one of the Address tabs:
®  Protocol: TCP/IP

* Host: the host computer where the Oracle database is installed

* Port: 1521

a. If the information does not appear, click Add Address.

A new Address tab appears.
b. Type these settings:
*=  Protocol: TCP/IP
=  Host: the host computer where the Oracle database is installed
= Port: 1521
c. Select Database Service in the Listener Location drop-down list.
d. Click Add Database.

In the dialog box that appears, make the following changes:
= Global Database Name: aadm
= Oracle Home Directory: oracle_home

For Oracle 9i, enter /u0l/app/oracle/product/9.2.0SE

For Oracle 10g, enter /u01/app/oracle/product/109.2.0SE
= SID:aadm

3. Choose File > Save Network Configuration to save your changes.

4. Close Net Manager.

Configuring the tnsnames.ora File (Optional)

1. Inthe Oracle Net Manager window, double-click the Local folder and select the Service Naming
folder.

2. Click Create X in the toolbar to add a service name.
The Net Service Name Wizard starts

3. Inthe Net Service Name field, type the name of the computer where the Oracle database is
located (usually the current computer). Click Next.

You are prompted to select a network protocol. Select TCP/IP (Internet Protocol) and click Next.

Type the name of the computer where Oracle is located in the Hostname field (the same name
you typed in step 3). Accept 1521 as the default port number. Click Next.

6. Select Oracle8i or later as the service name, and type aadm in the field. Click Next.
7. Click Test to test the service.
The test initially fails because the default uses the incorrect login.
Click Change Login to reset the username and password.
Type ast in the Username field and ast in the Password field and then click OK.
10. Click Test.
You should now see a message indicating that the test was successful.
11. Click Close.
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12. Click Finish to exit the Net Service Name Wizard.

13. From the Net Manager menu, choose File > Save Network Configuration to save the service name.

This completes the installation and configuration for the Agile PLM Datamart on an Oracle database
on Solaris.
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Troubleshooting

This chapter includes the following:
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Turning ON/OFF the COM_GENERATE_STATS

Datamart Installation

This section provides troubleshooting tips for Agile PLM Datamart database installation.

Setting the OracleServiceAADM Service to Start Automatically

When you restart the database server, make sure the Agile PLM Datamart database instance
started. If it did not start, it may be because the OracleServiceAADM service is not configured to start
automatically when the machine is restarted. To fix this problem, open the Windows Services window,
right-click the OracleServiceAADM service, and choose Properties from the shortcut menu. On the
General tab, select Automatic for the Startup Type field.

Listener Configuration

If the Oracle database listener is not properly configured, ETL tasks will not be able to connect to
the Datamart. For instructions on configuring the listener, see Adding and Configuring the
Database Listener ( 18).

Creating a Product Profile Table
After you create the datamart database and look at the installation logs, you may see the following
warning:

Error accessing PRODUCT_USER_PROFILE
Warning: Product user profile information not loaded!
You may need to run PUPBLD.SQL as SYSTEM

If a Product Profile table doesn’t exist on your database server, you can create one manually.
To create a Product Profile table:
1. Open a Command Prompt window.

2. Go to the oracle_home\sglplus\admin directory.

3. Start SQL*Plus and log in as system/manager:
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4.

D:\> sqlplus system/manager
Type @pupbld.sql and press Enter.

The Product Profile table is created.

Manually Installing the Analytics Plug-In for Windows

To manually install the plug-in for Windows:

1.

2
3.
4

o

10.

11.
12.
13.
14.

15.
16.
17.
18.

Stop the application server.2
Update the application.ear file with the Agile Analytics plug-in JAR files.
Create a folder named d:\AgileAnalyticsTmp.

Copy the application.ear file from the AGILE_HOME\agileDomain\applications\ folder and paste
it into the D:\AgileAnalyticsTmp folder.

CD D:\AgileAnalyticsTmp.
Set the Java environment as follows:

SET JAVA_HOME=%AGILE_HOME%\jdk
SET PATH=.;%JAVA_HOME%!\bin
SET CLASSPATH=.;%JAVA_HOME%\lib\tools.jar

Extract application.ear into D:\AgileAnalyticsTmp folder using the following command.
jar -xvf application.ear

Copy the analytics.jar file from the AA_ HOME\ ServerComponents folder into the
D:\AgileAnalyticsTmp folder.

Copy the analyticsclasses.jar file from the AA_ HOME\ ServerComponents folder into the
D:\AgileAnalyticsTmp\APP-INF\lib folder.

Modify the application.xml file located in the D:\AgileAnalyticsTmp\META-INF\ folder by adding
the following entry:

Find <security-role id="SecurityRole_1">
Replace <module id="Analytics">
<ejb>analytics.jar</ejb>
</module>

<security-role id="SecurityRole_1">
Delete the application.ear file located in the D:\AgileAnalyticsTmp\ folder.
Update agileclasses.jar for LicenseKeyAgile9.class.
Create a temp folder in the D:\AgileAnalyticsTmp\APP-INF\lib folder.

Copy the agileclasses.jar file from the D:\AgileAnalyticsTmp\APP-INF\lib folder to the
D:\AgileAnalyticsTmp\APP-INF\lib\temp folder.

Extract agileclasses.jar
jar -xvf agileclasses.jar
Delete agileclasses.jar

Go to the D:\AgileAnalyticsTmp \APP-INF\lib\temp\com\agile\admin\license folder and rename
the file LicenseKeyAgile9.class to LicenseKeyAgile9.class.bak.
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19. Paste new LicenseKeyAgile9.class provided.

20. Repack the agileclasses.jar file.

21. Open a command prompt window and go to the D:\ AgileAnalyticsTmp\APP-INF\lib\temp folder.
22. Execute jar -cvf agileclasses.jar *.*

23. Rename the agileclasses.jar file to agileclasss.jar.bak present at D:\ AgileAnalyticsTmp\APP-
INF\lib

24. Copy the agileclasses.jar file from the D:\AgileAnalyticsTmp\APP-INF\lib\temp folder and paste
it into the D:\AgileAnalyticsTmp\APP-INF\lib folder.

25. Delete the temp folder in D:\ AgileAnalyticsTmp\APP-INF\lib folder.
26. Package the files into application.ear using the following command:

D:\AgileAnalyticsTmp\
jar -cvf application.ear *.*

27. Copy the application.ear file located in the AGILE_ HOME\agileDomain\applications\ folder and
replace it with the application.ear file located in the d:\AgileAnalyticsTmp\ folder.

Note Be sure to use a backup of the original file.
28. Undeploy Agile.
29. Go to the AGILE_HOME\agileDomain\bin folder.
30. Execute UnDeployAgile.cmd
31. DeployAgile.
32. Go to the AGILE_HOME\agileDomain\bin folder.
33. Execute the DeployAgile.cmd.

Plugin Installation in Clustered Environments

This section provides information about installing the Agile PLM—Analytics Plugin in clustered
environments.

In general, the Analytics Plugin should be installed on all Agile Application Servers in the cluster.
After installing the Plugin, Agile PLM should be restarted on all servers in the cluster.

Plugin Installation in Clustered Environment with BEA Weblogic Server

For clustered environment with BEA Weblogic Server, the Agile PLM—-Analytics Plugin must be
installed on the administrative server and all managed servers.

Plugin Installation in Clustered Environment with Oracle Application Server

For clustered environment with Oracle Application Server, the Agile PLM—Analytics Plugin must be
installed on the repository host server where Agile PLM is installed. It is not required to install the
Plugin on non-repository host servers in the cluster.
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Error from Non-repository Host Server

When installing the Plugin on OAS — specifically, on the repository host server — you may see an
error from non-repository host server(s). This would occur after re-deployment of Agile PLM by the
Plugin Installer. To resolve this error, restart all non-repository host servers.

ETL Tasks Installation

This section provides troubleshooting tips for Agile PLM Datamart ETL tasks installation.

ETL Environment Variables and Classpath Settings

There are a few settings required for the Java code to be called successfully from the ETL task. For
example, if the Java classpath is not set correctly, you'll get errors when you try to run the ETL
tasks.

AA_HOME Environment Variable

There should exist an Windows Environment variable by the name AA_HOME and this variable
should have the path to the folder where Agile PLM Datamart ETL tasks are installed (for example,
D:\Agile\Agile921\Analytics).

Classpaths

Make sure the classes folder for Agile PLM Datamart ETL tasks (for example,
D:\Agile\Agile921\Analytics\classes) is included in the classpath. All JAR files contained in
<AA_HOME>\lib folder should also be included in the classpath.

Creating and Maintaining the Repository

The following error may be displayed in the DT/Engine logs or DT/Engine console window.

The database and the filesystem repositories are not in sync.

Note Some of the tasks may abort or produce incorrect results when executed.

To resolve this error, drop the current DT/Engine repository and recreate it.

To recreate the DT Repository from DT Console:

1. Inthe DT/Console Explorer, right-click the DT/Engine and select DT/Engine Properties from the
shortcut menu.

2. Click Drop, and then click OK to confirm the drop. Click OK again when the repository is
successfully dropped.

Click Create, and then click OK.
Click Set.

If prompted, log in again. (If you checked Connect Automatically when you logged in, you will
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not see this prompt.)

6. Click OK to dismiss the message that the repository exists and is current. Place the below list
of files in the DT/Engine storage folder

For example, D:\Program Files\Embarcadero\DTStudio\DTEngine2.3.1\storage
<AA_Home>\ETL\Common\templatexmIs\PLM_ADW_COM_ALL.xml
<AA_Home>\ETL\Common\templatexmIs\PLM_AA POST_TASK.xml
<AA_Home>\ETL\PA\templatexmiIs\PLM_ADW_PA_ALL.xml
<AA_Home>\ETL\PA_EXT\templatexmIs\PLM_ADW_PA_EXT_ALL.xml
<AA_Home>\ETL\PCA\templatexmIs\PLM_ADW_PCA_ALL.xml
<AA_Home>\ETL\QA\templatexmIs\PLM_ADW_PQA_ALL.xml
<AA_Home>\ETL\Staging\Common\templatexmIs\PLM_AST_COM_ALL.xml
<AA_Home>\ETL\Staging\PA\templatexmIs\PLM_AST_PA_ALL.xml
<AA_Home>\ETL\Staging\PCA\PLM_AST_PCA_ALL.xml
<AA_Home>\ETL\Staging\PQA\templatexmIs\PLM_AST_PQA_ALL.xml

7. Run the InstallAgileTasks.bat file found at <AA HOME>\ETL

Deploying the Agile PLM Datamart Task Chain

The Agile PLM Datamart ETL task chain is sometimes not deployed properly to the repository if the
repository is not set prior to the Agile PLM Datamart installer being run or the DT/Engine service is
not started during installation.

To deploy the Agile PLM Datamart task chain to the DT/Engine repository:
Run the InstallAgileTasks.bat found at <AA_HOME>\ETL.

Resizing the TEMP Tablespace

If you run a DT/Studio task ‘AST_TRNSLT_AST_COM_MAP’ and the task aborts, you may see the
following error in the task log file:

ORA-01652: unable to extend temp segment by 256 in tablespace TEMP

This error occurs because the TEMP tablespace initial size is too small and is not automatically
extended. You can correct this problem by turning Autoextend on and setting the maximum size for
the TEMP tablespace to be unlimited.

However, since the TEMP tablespace is the default temporary tablespace for the database, you
can't alter it. You can get around that limitation by creating another TEMP2 tablespace and making
it the default temporary tablespace while you drop and then recreate the TEMP tablespace.

To resize the TEMP tablespace:
1. On the Agile9 database computer, open a Command Prompt window.
2. Run the following command:

D:\> SET ORACLE_SID=Agile9
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3. Start SQL*Plus without connecting to the database:
D:\> sqglplus /nolog
4. Connect as the SYS user.
SQL> connect sys/<SYS_PWD> as sysdba
5. Create another temporary tablespace (TEMP2).
SQL> CREATE TEMPORARY TABLESPACE temp2 TEMPFILE
2 'D:\ORACLE\ORADATA\AGILE\TEMPO02AGILE9.ORA' SIZE 8M REUSE
3 AUTOEXTEND ON NEXT 8M MAXSIZE unlimited
4 EXTENT MANAGEMENT LOCAL UNIFORM SIZE 1M,;
6. Make TEMP2 the default temporary tablespace.
SQL> ALTER DATABASE DEFAULT TEMPORARY TABLESPACE temp2;
7. Drop the original TEMP tablespace.
SQL> DROP TABLESPACE temp INCLUDING CONTENTS AND DATAFILES;
8. Recreate the TEMP tablespace with the correct size.
SQL> CREATE TEMPORARY TABLESPACE temp TEMPFILE
2 'D:\oracle\oradata\AGILEQ\TEMPO1AGILE9.ORA' SIZE 512M REUSE
3 AUTOEXTEND ON NEXT 8M MAXSIZE unlimited
4 EXTENT MANAGEMENT LOCAL UNIFORM SIZE 1M;
9. Make the new TEMP tablespace your default temporary tablespace.
SQL> ALTER DATABASE DEFAULT TEMPORARY TABLESPACE temp;
10. Drop the TEMP2 tablespace.
SQL> DROP TABLESPACE temp2 INCLUDING CONTENTS AND DATAFILES;

Configuring the Autopurger Task

Autopurger is a built-in DT/Studio Task that purges the execution logs of the tasks. By default, the
autopurger task deletes logs older than ten days but retains logs for the ten most recent runs
regardless of how old they are.

To change the default setting, edit the OLDER_THAN_DAYS and
LEAVING_LAST_N_EXECUTIONS properties in the Autopurger.properties file located under
<DT_HOME>\config directory.

Generating a Thread Dump of a DT/Engine Session
If the DT/Engine fails to run an ETL task, you can generate a thread dump. A thread dump is a

textual dump of all active threads and monitors running in the Java Virtual Machine. It gives the
exact line of code where the ETL task is hanging, allowing Agile Support to diagnose the problem.
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To create a thread dump of a DT/Engine session:

1.

6
7
8.
9

Note

Start DT/Engine from the Command Prompt:
a. Navigate to the <DT_HOME>/bin folder from windows explorer.

b. Edit the dt_engine.bat file to remove the -Xrs option from the batch file, i.e., edit the
following line:

set _jvm_args=-Xrs
to

set _jvm_args=
c. Make sure DTEngineManagerService is NOT running.
Open a Command Prompt window and go to <DT_HOME>\bin.
Start the engine using the following command:

dt_engine start
Start DT/Console.
Run the ETL task that you had problems running earlier.

If the task hangs for a long time (for example, it exceeds the duration of the last successful
execution run by two hours), take a thread dump by pressing CTRL-BREAK in the DT/Engine
Command Prompt window.

In the Command Prompt window, scroll back until you reach the line containing “Full thread
dump.”

Right-click the title bar, and choose Edit > Mark. Highlight the entire text of the thread dump.
Right-click the title bar, and choose Edit > Copy.
Paste the thread dump into a text file and save it

Send the thread dump file to Agile Support for analysis.

If you start DT/Engine using the DT Engine Manager user interface instead of a Command
Prompt, you cannot generate a thread dump when an ETL task fails.

Periodically Restarting the DT/Engine Service

To ensure adequate performance of DT/Engine, periodically restart the DT/Engine Manager service
at least every ten (10) runs of the ETL tasks or every seven days, whichever occurs first.

Turning ON/OFF the COM_GENERATE_STATS

By default, the COM_GENERATE_STATS is in OFF state

To turn it ON:

1. Make sure Agile PLM Data mart tasks are installed

2. Stop DTEngine

3. Add COM_GENERATE_STATS task as the 1st Task to the Task Chain.

a. Modify AA_ HOME\ETL\Common\adw_com_datasource.properties and
AA_HOME\ETL\Common\adw_com_taskchain.list to add the tasks.
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Note Make sure that all task chains should be separated by comma(,)

Restart the DT Engine.
Restart DT Engine Manager Service

4
5

6. Login to DTENngine through DTConsole

7. Purge Logs for Tasks and Task Chain menu items
8

Execute AgileAnalytics Task Chain
To turn it OFF:

1. Make sure that Agile PLM Data mart tasks are installed
2. Stop DTEngine

3. Remove COM_GENERATE_STATS task from the Task Chains.

a. Modify AA HOME\ETL\Common\adw_com_datasource.properties and
AA HOME\ETL\Common\adw_com_taskchain.list to remove the tasks.

Restart the DT Engine.
Restart DT Engine Manager Service
Login to DTEngine through DTConsole

Purge Logs for Tasks and Task Chain menu items

© N o a A

Execute AgileAnalytics Task Chain
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